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Terms of Usage 

PCG Tools is a free application, however the executable and the source code may never be used for 

commercial reasons. 

Also the application may not be spread except by the developer. It may not be uploaded to web sites, 

peer to peer networks, spread by email or by other means without permission of the developer.  

The reason for this, is that the developer maintains a list of people who are using PCG Tools and 

when a new update is available, it will be send to everybody on this update list, to make sure 

everybody always receives the latest version. 

This application is not affiliated by Korg, so requests, bugs, wishes, questions etc. should be directed 

to michel.keijzers@hotmail or being posted on the main PCG Tools 

(www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765)  thread or one of the model specific 

threads at www.korgforums.com. (see paragraph 1.4). 

WPF MDI 

This application uses third party source code. The license can be read in file wpfmdi_license.txt. 

Notice 

The developer reserves the right to make improvements or changes in the software product and the 

manual at any time and without notice. 

Disclaimer 

THE DEVELOPER, MAKES NO WARRANTIES, EITHER EXPRESSED OR IMPLIED, WITH RESPECT TO THIS 

MANUAL OR WITH RESPECT TO THE SOFTWARE DESCRIBED IN THIS MANUAL, ITS QUALITY, 

PERFORMANCE MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE. 

THE APPLICATION AND MANUABL IS PUBLISHED AS IS. IN NO EVENT SHALL THE DEVELOPER BE 

LIABLE FOR INCIDENTAL OR SEQUENTIAL CORRUPTION OF FILES TOUCHED BY THIS SOFTWARE. 

 

© 2011-2012 Michel Keijzers (MikeSoft) 

All rights reserved.  

 

(this text will also be published in the readme.txt being published with the application). 

  

http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765
file:///G:/Data/Eigen/Informatica/KorgKronosTools/KorgKronosTools/Documentation/www.korgforums.com
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Kronoscopie http://www.kronoscopie.fr 

Kronos-mw http://kronos-mw.com/ 

Dreamland Recording Studio http://www.dreamland-recording.de/ 

Keller12 http://www.keller12.de 

Karo Sound Development http://www.karo-sounds.com 

Kronos AL-1 Editor http://www.chrutil.com/kronos 

Supernatural Heroes http://www.thesupernaturalheroes.com/ 

Muziekhuis (Music House) Lyana http://www.lyana.nl/ 

Toon Martens Project http://www.toonmartensproject.net/ 

Source Code Management https://github.com/ 

Source Code Management https://www.assembla.com  

Core FTP http://coreftp.com/ 

PC Service & Repair http://www.cyber-tek.pl/ 
Table 1: List of Internet Links 

List of Email Addresses 

Person / Company Email Address 

Michel Keijzers / MikeSoft mailto::michel.keijzers@hotmail.com 
Table 2: List of Email Addresses 

  

http://www.kronoscopie.fr/
http://www.korgforums.com/forum/phpBB2/
http://www.dreamland-recording.de/
http://www.keller12.de/
http://www.karo-sounds.com/
http://www.chrutil.com/kronos
http://www.thesupernaturalheroes.com/
http://www.lyana.nl/
http://www.toonmartensproject.net/
https://github.com/
https://www.assembla.com/
http://coreftp.com/
http://www.cyber-tek.pl/
mailto::michel.keijzers@hotmail.com
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List of Abbreviations 

Abbreviation Description 

ASCII American Standard Code for Information Interchange 

BRng (Pitch) Bend Range 

Cmb Combination. 

Combi Combination. 

CSV (file) Comma Separated Value (file) 

EDS Enhanced Definition Synthesis, synthesis engine used by Korg M3 and 
M50. 

EXI A model/physical engine to create sounds, not (principally) based on 
samples. 

Fav Favorite 

FTP File Transfer Protocol 

GM General MIDI 

GUI Graphical User Interface 

HD1 High Definition 1, synthesis engine used by Korg Oasys and Kronos 
workstation models. 

HI Hyper Integrated, synthesis engine used by Korg Triton and Karma 
workstation models. 

I / Int Internal program or combi bank 

KARMA Kay Algorithmic Realtime Music Architecture 

MIDII Musical Instrument Digital Interface 

OSC Oscillator 

PCG Programs, Combis, Global 

Porta Portamento 

Prg Program 

Pri Priority 

SNG Song 

Sta Status 

Trans Transpose 

U User program/combi bank 

UI User Interface 

Vel Velocity 

Vol Volume 

XML Extensible Markup Language 

XSL Extensible Stylesheet Language 
Table 3: Abbreviations 
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Glossary 

Term Description 

ASCII Table Table with control code characters and characters like 0..9, a..z, A..Z a and 
special symbols. 

Banks Listview The left list shown in the PCG file which is active when a thick grey box is 
drawn around it. It contains the banks of the selected type. 

Bend Range See Pitch Bend Range. 

Broken combi or set list 
slot 

A combi or set list slot is called broken, when a used program/combi is 
unintentionally changed or overwritten. 

Category Programs and combis are grouped in categories (and depending on the 
workstation model, sub categories). 

Clearing Clearing a patch is similar to initializing a patch (on a workstation), but 
only sets certain parameters and sets an empty string instead of e.g. "INIT 
COMBI". 

Combi A combination of 8 or 16 timbres (depending on the workstation model) 

Combi Bank A bank of 128 combis. 

Comma Separated 
Value (file) 

File with columns, split by columns which can be used for importing in 
spreadsheets, like Microsoft Excel©. 

Command A command is an action that can be selected to be performed. 

Compacting Compacting patches removes all empty selected patches down and all 
nonempty selected patches up. 

Complete PCG File A PCG File that contains the complete contents of the PCG information of 
a workstation model. 

Copy The command to select patches for copying patches to another location. 

Cut The command to select patches for moving patches to another location. 

Delete There is no Delete command, patches can either be cleared or can be 
compacted. 

Dialog A window that needs to be closed before continuing with the application. 

Duplicate Patches Patches are considered duplicates if they are equal (i.e. all parameters are 
equal), optionally ignore the name of the patch. 

Effect An effect can be used to alter a patch and is added at the end of the 
signal chain. 

Empty Patch A patch with an empty name, this does not have to mean it is inaudible. 

Erase There is no Erase command, patches can either be cleared or can be 
compacted. 

Error Dialog A dialog to notify the user of a problem that occurred while performing a 
command. 

File Transfer Protocol A protocol for communication for transferring files, in our case PCG files 
over ethernet. 

General MIDI A standardized set of 1 or more program banks which contain the same 
predefined set of programs. 

Global MIDI Channel The MIDI channel the workstation itself is assigned to. 

Index The index of a patch inside a bank or set list. E.g. program I-A040 has 
index 40. 

Init Patch A patch that is initialized, assigned to default values and containing the 
word 'INIT' in its name. 

Instrument Definition 
File 

A file that contains a patch list to be used for (external) sequencers, e.g. 
Cubase®. 
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Term Description 

Internal Bank Banks denoted as I-A to I-G or INT-A to INT-D and considered internal 
banks with predefined programs/combis (although can also contain user 
defined programs/combis). 

Internal Memory Internal workstation Memory, which contains the programs, combi, 
global info and depending on the workstation model more info. 

KARMA Generates MIDI data based on algorithms, can be seen as an advanced 
arpeggiator. 

Layer Multiple programs that are assigned to the same key/velocity zone. 

Memory Computer Memory, which is the RAM memory of the computer which is 
used. 

Keyboard Zone The range of keys in which a timbre is audible. 

MIDI A communication protocol that let musical devices (including computers) 
communicate with each other. 

MIDI Channel The channel on which a related item is assigned to, can be 1 to 16. 

Modeled Program A program that is created by a non sample based engine, like Moss or one 
of the EXIs of a Korg Oasys or Kronos. 

Oscillator Repeat waveform that is the basis of a sound. 

Paste Storing (a part of the) copied patches to a destination. 

Patches List View The right list shown in the PCG file which is active when a thick grey box is 
drawn around it. It contains the patches of the first selected bank. 

Patch Another name for a program, combi or set list slot. 

PCG File A file that contains programs, combis and global information (and more). 

Pitch Bend Range The range of the frequency for moving the joystick in the X direction. 

Portamento When playing legato, the frequency gradually moves toward the new key 
(frequency). 

Pri Priority of a timbre. 

Program A sound that contains up to two oscillators. 

Program Bank A bank of 128 programs. 

Read Only A bank that is read only cannot be modified/written to (e.g. the GM 
program banks). 

Sample A waveform that is the base of a sound. 

Sampled Program A program that is based on samples (a program created with the AI2, EDS 
or HD1 engine). 

Semitone A half tone, e.g. the difference in pitch between a c and c#. 

Sequencer A built in feature of a workstation or an external application for creating 
songs. 

Set List Slot One of the 128 slots inside one set list which refers to a program, a combi 
or a song. 

Set List A list of 128 set list slots. There are 128 available in the Korg Kronos. A set 
list can be seen as a bank for set list slots. 

Song A musical piece that can be recorded in some workstation models and 
stored in the internal memory. 

Split Multiple programs that have a different key zone on the same keyboard 
of a work station. 

Status Status of a timbre. 

Timbre A part of a combi which can reference to an external board, can be 
switched or (normally) references to a program. 

Transpose The shifting of a timbre in semitones. 
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Term Description 

User Bank Banks denoted as U-A to U-G and considered user banks with user 
defined programs/combis (but also can contain predefined 
programs/combis). 

Velocity Zone The velocity range in which a timbre is audible. 

Warning Dialog A dialog to notify the user of something to take into account. 

Work Station (Model) A type of work station, e.g. Korg Triton Extreme, Korg M3, Korg Kronos. 

Workstation Dependent 
Feature 

Some features are not available on all workstation models.  

XML File A file that contains data which can be used for being shown in a browser 
or use as export file for other applications. 

XSL File A file that defines how the associated XML file should be visualized. 
Table 4: Glossary 
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History Changes 

Version Date Changes 

1.0.0.150 10-Apr-2012 Initial version. 

1.1.0.168 6-May-2012 - Added Cut & Paste functionality. 
- Added external links. 
- Added more extensive application setup information. 
- Added list of internet links and email addresses. 
- Added history/changes. 

1.3.0 14-Jul-2012 - Added Assigned Clean Program for cleaning timbres in Combi Window. 
- Added external links/donators. 
- Added chapter about standalone installation and installation path. 
- Added splash screen and special events. 
- Changed screen shots of new GUI look. 
- Added information about setup/installation problems. 
- Added screenshots/info about incompatibility between workstations. 
- Added favorite column for set list generator patch lists. 
- Added settings menu. 
- Added remark about Triton and Korg workstation model names. 
- Added remark about copying between Korg M3 and Korg Triton files. 

Table 5: History Changes 
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Foreword 

Thank you 

… for showing interest in this application and reading the manual. In this manual I try to explain all 

functionality that is covered by PCG Tools and also add tips and examples to make it more 

worthwhile to read through this manual. 

History 

Around May 2011, this application started as a small challenge being performed in a few days time.  

A forum member at http://www.korgforums.com posted a thread about a missing feature that exists 

in Korg workstations for decades.  

When changing a program, all combis using that program will be changed too. The missing feature is 

that one cannot know easily by which combis (or set list slots in case of a Korg Kronos) a program is 

used. The only solution is to go through all combis (and set list slots) and check if the program is 

inside the timbres list or being referenced by the set list slot. With the Kronos having the possibility 

of thousands of combis and set list slots this is an impossible task to do manually. 

Since I am a professional software engineer and I was very interested in the Korg Kronos as 'upgrade'  

for my Korg M50 and Triton Extreme, and because I wanted to learn more about a certain 

programming language (C#) professionally, I wrote in the forum I could write a small application that 

could generate a list of all programs together with all combis and set list slots it was used in. I wrote I 

could do it in a day but I needed two.  

That small 'application' was what now is the base of the List Generator, part of the PCG Window and 

part of the complete PCG Tools application. The first version was published in the begin of July, 2011. 

Present 

Now, about 9 months later, the application has gained a lot more functionality, I am the proud owner 

of a Kronos, I learned a lot about the programming language  and more than 400 Korg owners (I 

assume) are using this application. Besides, I learnt a lot about Korg workstations by being active in 

www.korgforums.com, and have very nice contacts with a lot of Korg owners and participants of that 

site. Also, I have good contacts with some employees inside the Korg company.  

Currently, the base of the application is an application where both multiple PCG and Song (SNG) files 

can be used.  The application not only can generate lists, but serves as a Librarian and even a bit as 

an Editor. 

The first version was only supporting the Korg Kronos, the current version supports all recent Korg 

workstations, like the Korg Kronos, Korg Kronos X, Oasys, M3, M50, all Tritons and the Karma. 

And for software insiders: the first version of this application started with about 500 lines, the 

current code has around 20,000 lines and still is growing. 

http://www.korgforums.com/
file:///G:/Data/Eigen/Informatica/KorgKronosTools/KorgKronosTools/Documentation/www.korgforums.com
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Thanks 

This application would never have been such a success with help of others. The following 

people/teams (in random order) have greatly helped me. 

Sharp and other moderators at KorgForums.com: Due to this forum website, my application received 

a lot of attention and he helped me out with gaining even more exposure. 

Korg R&D Product Manager Dan Philips: He answered numerous questions, forwarded my 

sometimes detailed questions to other employees of Korg. He arranged valuable documentation to 

speed up certain parts of this application. 

Korg Product Manager Rich Formidoni: He answered also numerous questions and gave me the 

encouragement to continue. 

Korg R&D Software Engineer Steve Pavao: He answered several specific questions with detailed 

answers and provided a lot of in depth information to speed up the programming of my application. 

McHale and Phinnin, forum members of KorgForums.com: without their help and help from various 

other members I was not as far as I would be know. Especially during the time I did not have a Korg 

Kronos myself, they tested a lot of test versions and spent a lot of time helping me analyzing the 

structure of PCG files. 

Mathieu Maes for starting the development of a web based version of PCG Tools and for the 

beautiful PCG Tools logo he created. 

Francois Rossi for his effort to make a French translation. Although it was too difficult/time 

consuming to have a French version already, in future it is thinkable there will be one. 

Vanni Torelli for his great theme I could use to look the screens better, for his improvements in the 

GUI and his help with the source code management system. 

All beta testers, some already mentioned above and further JimKnopf, Cello, PpublicDuende, 

rs.felicio, AdDeRoo and MattGerassimof for testing the application and proofreaders and manual 

who helped me to improve the quality of the application and manual. Also everyone who sent 

helpful additions, ideas, compliments and bugs. 

I also want to thank xadet, the coordinate/project member from WPF Multiple Document Interface, 

which I used for the external library to display multiple windows. 

Furthermore, I want to thank the members of the Assembla project, which is a great tool for 

managing versions and online storage of source code. 

Also, I like to thank the members of GitHub, which is a great version system for source code. 

And last of not least donators of my application. It means a lot to me that this application is seen as a 

useful and valuable tool.  
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Future 

I get regularly wishes to add new features or improve features for PCG Tools. The list can be found at 

http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765 under the post 'Wish List' 

which contain a quite long ordered list of items that people have asked for or what I consider 

worthwhile. 

However, the list is growing harder than I can implement, so probably not all will be implemented in 

the end, but the application will grow gradually in the future. 

http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765
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1 About PCG Tools 

1.1 Relation to Korg.com 
This application is not affiliated with Korg neither with KorgForums or any other company/website.  

This means that Korg does not decide the content of either the manual or the features of the 

application, nor should they be contacted for info, wishes, requests or other questions about this 

application or manual. 

1.2 Acquiring the application 
A free copy (including future updates) can be simply acquired by writing a mail to 

mailto::michel.keijzers@hotmail.com and request for the application. You also can send me a private 

message in www.korgforums.com or post a message on one of the PCG Tools threads on that forum 

(see Table 6).   

There is only one application which supports all supported Korg workstation models. 

1.3 Contact 
You can contact me by sending an e-mail at the address above for bug reports, ideas, wishes and all 

remarks related to PCG Tools. 

1.4 Web site 
PCG Tools does not have a dedicated website, but at www.korgforums.com there are several threads 

that serve as public communication channels between users and the developer.  

The main PCG Tools thread can be found at: 

http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765 

In Table 6 the Korg workstation model specific threads are shown. 

Korg Model(s) Thread 

Korg Kronos and Kronos X http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765 

Korg Oasys http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63766 

Korg M3 http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64081 

Korg M50 http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64028 

Korg Triton Classic http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64748 

Korg Triton Studio http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64747 

Korg Triton Extreme http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63994 

Korg Triton LE http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64749 

Korg Triton Rack http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64923 

Korg Karma http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64924 
Table 6: PCG Tools threads at KorgForums 

1.5 Donations 
Although PCG Tools is free, if you think this application is worthwhile to you, saving you time or 

otherwise useful and you like to donate some money, please consider sending a donation. The 

donation button can be found in the About box (Help menu, About menu item).   

mailto::michel.keijzers@hotmail.com
http://www.korgforums.com/
file:///G:/Data/Eigen/Informatica/KorgKronosTools/KorgKronosTools/Documentation/www.korgforums.com
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63766
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64081
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64028
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64748
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64747
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63994
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64749
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64923
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=64924
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Paypal is selected because it is a secure site (although they charge a small fee for their services).  

People who donate, can also send a link and/or logo which I will add in the External Link 

s window in the About menu within PCG Tools. 

Btw, the hours I worked at the application are not counted but must be somewhere between 250 

and 500 hours. 
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2 About the Manual 

2.1 Introduction 
This manual will be regularly updated, however screenshots will only be updated every now and 

then. This means that there might be small differences in the screen shots and the actual application, 

but never in such a way that the explained features are not explained well enough. 

2.2 Online Version 
This manual is also accessible online at: 

http://www.korgforums.com/support/kronos/Manual%20PCG%20Tools.pdf 

2.3 How to use this manual 
Chapter 3 (Overview) shows what is possible with PCG tools. It gives an overview of the main 

features and also handles system requirements and setup. 

Some settings from timbres, used in a combi are not supported by all workstation models. 

[NOTE]: From this page, workstation dependent features are not mentioned explicitly unless it does 

not clutter up the text. 

Chapter 4 (Korg Files) contains a description of what a PCG and SNG file is and an explanation of the 

contents of these files. If you are familiar with these files, you can skip this chapter (although some 

global terms are explained which are used heavily in the manual and application). 

Chapter 5 (Workflow) describes the way how to use this application in relation to (the) Korg 

workstation(s), how to get the PCG file from the Korg workstation to the computer into this 

application and back to the workstation. 

Chapter 6 (Main Screen) handles the main screen and generic options, how to load and save files for 

example. 

Chapter 7 (Using PCG Files) handles PCG files and the list generator for PCG files and is the largest 

part of the manual. 

Chapter 8 (Using SNG (Song) Files) handles SNG files and what is possible with these files. 

Chapter 9 (Q & A and Trouble-Shooting) shows a list of frequently asked questions & answers and 

solutions for problems you could encounter while using this application. 

Chapter 10 (Keyboard Usage & Shortcut Keys) shows a list with all shortcut keys and how to make 

selections faster by using default Windows behavior that might not known by every user. 

http://www.korgforums.com/support/kronos/Manual%20PCG%20Tools.pdf
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2.4 Conventions 
During this manual several special keywords are used, shown in brackets. The meaning is explained in 

Table 7. 

Keyword Meaning 

[BACKGROUND] Shows background information, not necessary for understanding the 
paragraph. 

[KRONOS ONLY] This keyword means the feature is model dependent for the specified 
workstation model, check paragraph 3.5 for a complete list. It only is used 
when a complete paragraph or part is dependent on a workstation 
feature. Note that where the Kronos is mentioned, also Kronos X is 
meant. 

[TIP] A tip explains a possibly non trivial usage of this feature. 

[WARNING] Reason why to be careful to use this feature. 

[NOTE] A message that is not directly coupled to this feature/section. 

[EXAMPLE] Example. 
Table 7: Convention keywords 

All website reference and email addresses in this manual are hyperlinked, meaning you can click 

them with the Control key together with the left mouse button to navigate to the link (in your default 

browser) or sending a mail (with your default email application).
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3 Overview 

3.1 Solutions for managing PCG and SNG files 

3.1.1 Introduction 

PCG Tools consists of several parts. The major part handles PCG files. With PCG Files, the following 

main functionality is possible: 

 List generator, which is capable of generating all kind of useful lists. 

 Librarian functionality, which is capable of (re)arranging and modifying programs, combis and 

set list slots. 

 Editor functionality to edit (certain) parameters inside programs, combis and set list slots. 

The Librarian and Editor functionality are seamlessly connected.  

Also some functionality regarding song (SNG) files is available. 

For each of the main functionalities, solutions are given to show what it can be used for. 

3.1.2 List Generator solutions 

The list generator can give you answers on the following questions and wishes: 

 I would like to have a voice name list that contains all (or certain) of YOUR programs, combis 

and/or set list slots. 

 I want such lists in alphabetical order, ordered by category/sub category or ordered by 

Bank/ID. 

 I want to be able to open these lists in Excel or in a(n internet) browser. 

 I also want to make lists that are printable, to be used as set list for a gig for example. 

 I want to change a program, but I do not want to break a combi. How do I know which 

programs are used by which combis?  

 How do I know which programs and combis are used in which set list slots? [KRONOS ONLY] 

 Do I have (almost) identical patches in my file and where are they? 

 I want to have an overview at a glance for all timbres and its most important parameters of 

one or more combis. 

 I know part of the name of a patch but I cannot remember its location. I even don't know if it 

was  a program, combi or set list slot. Where can I find it (or them)? 

 I have marked programs and combis as favorite, but I want to have a list of them. [KRONOS 

ONLY] 

3.1.3 Librarian solutions 

For the librarian functionality, the following wishes can be performed: 

 I want to move one or more programs up or down but I do not want to break any combis or 

set list slots they are used in. 

 I want to move one or more combis up or down but I do not want to break any combis or set 

list slots they are used in. 

 I want to move one or more set list slots up or down. [KRONOS ONLY] 
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 I want to clear one or more patches. 

 I have removed a lot of patches, and I want to remove the created gaps (by moving all used 

patches up). 

 I want to copy one or more programs inside my PCG file or from one PCG file to another. 

 I want to copy one or more combis inside my PCG file or from one PCG file to another 

including all the programs used by those combis. 

 I want to copy one or more set list slots inside my PCG file or from one PCG file to another 

including all the programs and combis used by those set list slots. [KRONOS ONLY] 

 I want to move patches inside my PCG file and automatically fix all references from combis or 

set list slots referencing the moved patches. 

 I want to make a PCG file that only consists of the copied combis including their used 

programs. 

 I want to make a PCG file that only consists of the copied set list slots including their used 

programs and combis (and the programs used in those combis). [KRONOS ONLY] 

3.1.4 Editor solutions 

For the editor, the following wishes are granted: 

 I want to use a PC keyboard to change the name of a program or combi. 

 I want to use a PC keyboard to change the description of a set list slot [KRONOS ONLY] 

 I want to use returns in the description of a set list slot to format the text better. [KRONOS 

ONLY] 

 I want to change the category and sub category of a patch. 

 I want to mark or unmark the favorite setting of a program or combi. [KRONOS ONLY] 

3.1.5 Additional solutions 

 I want to make an instrument definition file of my own file for use in Cubase™. 

3.1.6 Song (SNG) files 

For song files, the following wishes are possible. 

 I want to see at a glance which songs are inside an SNG file. 

 I want to see at a glance the name and file locations of the user samples used in my SNG file. 

3.2 What is not possible with this application? 
Simply said, it cannot do what is not written above, but some of them are: 

 It is not possible to copy patches from one model to another (e.g. copy patches from a Triton 

to an Oasys or vice versa). The reason is that the engines, sample data and/or parameter  

value(s) are different from model to model). 

 It is not a DAW or has any integration with a sequencer. Korg has announced to publish this 

functionality in their Kronos Editor and for most other workstation models DAW integration 

is already available. 

 It is not an editor for changing every possible parameter. Korg has announced to publish this 

functionality in their Kronos editor and for most models an Editor is already available. 

 



Chapter 0 - Korg Files 
 

 
7 

 

3.3 System Requirements 
This application uses the DotNet Redistributable Framework 4 which is installed automatically during 

setup. This library (thus PCG Tools too) needs the system requirements shown in Table 8. 

Supported operating Systems Windows 7, Windows 7 SP1 
Windows Server 2003 SP2 
Windows Server 2008, Windows Server 2008 R2 
Windows Server 2008 R2 SP1 
Windows Vista SP1 
Windows XP SP3 

Supported architectures x86, x64 

Minimum memory At least 512 MB Ram 

Processor Pentium with at least 1 GHz 

Hard disk space X86: 850 MB1, x64: 2GB1 

Needed application Internet Explorer 5.0.1 or equivalent browser 
1Only if Microsoft DotNet Framework 4 is not already installed, otherwise the hard disk space 

required is negligible. 

Table 8: Windows System Requirements 

3.3.1 Non Windows Computers 

If you have a Macintosh, Linux or other system, you need to have a Windows emulator application. 

Table 9 shows a list of a few emulators/virtualization software that can be used. 

Platforms Application 
Name 

License Website 

Windows, Mac OS X, 
Linux, Solaris 

VirtualBox Free https://www.virtualbox.org/wiki/Downloads 

Mac OS X VMWare 
Fusion 

Paid http://www.vmware.com/products/fusion/feat
ures.html 

Mac OS X Parallels Paid http://www.parallels.com  
Table 9: Virtualization Software for non Windows platforms 

If you do not want to use a Windows emulator for whatever reasons, take a look at the next 

paragraph. 

3.3.2 Web version of PCG Tools 

There is a web version of PCG Tools, currently with limited functionality but under development, but 

is fully platform independent. 

It is  developed by Mathieu Maes and more information can be found at  

http://www.korgforums.com/forum/phpBB2/viewtopic.php?p=448479#448479 

and the application can be found at 

http://pcg.webberig.be  

https://www.virtualbox.org/wiki/Downloads
http://www.vmware.com/products/fusion/features.html
http://www.vmware.com/products/fusion/features.html
http://www.parallels.com/
http://www.korgforums.com/forum/phpBB2/viewtopic.php?p=448479%23448479
http://pcg.webberig.be/
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3.4 Setup 

3.4.1 Instructions 

After receiving the email with the application, perform the following steps to install the application: 

 Rename the file "PCG Tools Publish 2.zzz" to "PCG Tools Publish 2.zip", i.e. change the 

extension from 'zzz' to 'zip'.1.  

 Unzip the file (to the same location as before in case of a reinstall or update). 

 Open the unzipped files. 

 Run 'setup.exe' 

 Follow the instructions 

The instructions that follow may differ from operating system to operating system, but also for the 

security settings and other settings on the computer. The following screens however probably show 

up independently of the settings: 

 

Figure 1: Setup Application Install - Security Warning 

  

                                                           
1
 The reason for this is that zip files are likely to be seen as spam by certain email servers and therefore remove 

it or store it in a junk mail folder. 
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When selecting the link 'More Information…' at the bottom  you will see the following screen: 

 
Figure 2: Setup Application Install - More Information 

Please select the Install button in the Application Install screen. 

Because PCG Tools is not created by a company but by a 3th party single developer and not for 

commercial goals, it is not feasible to buy or license a so called Authenticode (see 

http://technet.microsoft.com/en-us/library/cc750035.aspx for more information) since it costs a 

substantial  sum of money. However, to give at least some trust in PCG Tools, please refer to the 

following internet link where users of this application give their trustworthiness to the application: 

http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=71495&watch=topic&start=0&sid=d7

663dc8ef5c793d095cef9a08107034 

3.4.2 Installation Path 

The application is installed in the following location: 

 c:\users\username\appdata\local\apps\2.0 
 

Where username is your login (or login at install time). The name may differ in case a different 

language is used. 

3.4.3 Installation Problems 

Always unzip and install the application from the same folder as before (in case of an 

update/reinstall). If you still run into problems, remove the following folders: 

http://technet.microsoft.com/en-us/library/cc750035.aspx
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=71495&watch=topic&start=0&sid=d7663dc8ef5c793d095cef9a08107034
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=71495&watch=topic&start=0&sid=d7663dc8ef5c793d095cef9a08107034
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c:\users\username\Local Settings\Apps \2.0 in case of Windows XP 

c:\users\username\AppData\Local\Apps\2.0 in case of Windows Vista, Windows 7 or Windows 8 

For other Windows (or emulator in case of Apple Macintosh/Linux) a similar folder should be 

deleted. 

3.4.4 Standalone Installation 

PCG Tools can also be installed without having an internet connection available.  

Before performing the steps mentioned in the previous paragraph, do the following steps: 

1. Open the configuration screen/panel, then selecting the option 'applications'; the exact 

names depend on the OS so it may vary. If you cannot find the screen, assume it is not 

available, and continue with step 3. 

2. Check if in the list that is shown if there is one or more variations of the Microsoft .NET 

Framework 4.0 library is present.   

If such a library is present, only copy the .zzz file received by email to e.g. a USB stick or 

external hard disk and continue with step 6. If you encounter problems while or after 

installing, try to install the framework anyway. Note that you need the 4.0 version, older 

versions should not be removed, but are not being used by PCG Tools. 

 

 

Figure 3: Microsoft Library 

 

3. Assuming such a library is not present, download and copy it to the USB stick or external hard 

disk. The download location is:  

http://www.microsoft.com/en-us/download/details.aspx?id=17718 

4. Attach the media to the target computer 

5. Install the .NET 4.0 library. 

6. Continue with the steps in the previous paragraph. 

http://www.microsoft.com/en-us/download/details.aspx?id=17718
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3.4.5 Microsoft Library 

If the needed Microsoft DotNet 4.0 framework is not already installed, it will be done automatically 

by the setup procedure (if an internet connection is available). The installation of the DotNet 

framework may take some time, depending on your computer system. However, it needs to be 

installed only once and not for future updates. Chances are big, that the DotNet framework is already 

installed on your computer, since this library is used for numerous other applications too. 

After setup, start the just installed application by clicking on the created desktop icon or select it in 

the installed applications. 

3.5 Workstation Models 

3.5.1 Supported Workstation Models 

PCG and SNG files from the following Korg workstation models are supported: 

 Korg Kronos X 

 Korg Kronos 

 Korg Oasys 

 Korg M3 

 Korg M50 

 Korg Triton Extreme 

 Korg Triton Classic 

 Korg Triton Studio 

 Korg Triton LE 

 Korg Karma 

3.5.2 Workstation Dependent Features 

In Table 10 below, all feature difference, which are important for PCG Tools and this manual are 

listed per workstation model. 

Model -> 
 
Feature  

Korg Kronos / 
Korg Kronos X 

Korg Oasys Korg M3 Korg M50 Korg 
Triton 
Series 

Korg 
Karma 

Karma √ √ √ SW only - - 

Sampler √ √ √ - Option - 

Set Lists √ - - - - - 

Favorites √ - - - - - 

Sub Categories √ √ √ √ - - 

Wave 
Sequences 

√ - - - - - 

Mute setting in 
timbres 

√ √ √ √ - - 

Priority setting 
in timbres 

√ √ - - - - 

Table 10: Model Differences 

Karma is an advanced arpeggiator (and more). For the Korg M50, Karma is an optional software 

package to be ran on a connected computer, for some other work station models it is built in. 
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With a sampler, user samples can be recorded or loaded. These samples can be used as base samples 

for programs. 

Set Lists are used for easily organizing programs and combis. 

Favorites and sub categories are used for easily selecting/filtering programs and combis. 

Wave Sequences are waveforms that are sequenced after each other. 

Also some settings from timbres, used in a combi are not supported by all workstation models. 

[NOTE]: From this page, workstation dependent features are not mentioned separately unless it does 

not clutter up text. 
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4 Korg Files 
There are various kind of files that can be imported/exported from/to a Korg workstation. These file 

types are: 

 PCG files: Files containing programs, combis, global sections and more (see paragraph 4.1) 

and these files have the extension ".PCG". 

PCG Tools can read these files to be analyzed and to modify. 

 Song (SNG) files: Files containing one or more sequencer songs (see paragraph 4.2) and these 

files have the extension ".SNG". 

PCG Tools can read these files to be analyzed. 

 (User) sample files: Files containing samples and parameters related to it (see paragraph 4.3), 

having extensions ".KMP", ".KSF" and  ".KSC". 

These files are not supported by PCG Tools. 

Normal MIDI (.MID) files can also be used on Korg workstations, however these are not Korg specific 

and are also not supported by PCG Tools. 

4.1 PCG Files 
Korg uses so called PCG files to store programs, combinations, global section and more: 

 Program Banks 

 Combi Banks 

 Global section 

 Set Lists 

 Wave Sequences 

 Drum Kits 

 Arpeggios 

Since the first three items were the first and important items to be stored in a PCG file, that is where 

the abbreviation "PCG" comes from (Programs Combination Global). 

A PCG file consists of all (or a part of) the patch memory of a Korg workstation. A patch can be a 

program, a combi or a set list slot. This means, that a PCG file can contain all program banks, all 

combi banks and the global section, but it also can contain only a few program banks, or some combi 

banks and the global section. On the Korg workstation the content to be saved in a PCG file can be 

selected when saving a PCG file. 

4.1.1 Structure 

Figure 4 shows the structure of a complete PCG file. A complete PCG file is a PCG file where the 

complete internal memory is stored (i.e. all program banks, all combi banks, all set list slots (if 

supported by the workstation model), the global section etc.). Creating a complete PCG file is also 

the default setting when saving a PCG file. 
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Figure 4: PCG File Structure 

A solid line arrow means that the source (where the arrow starts from) consists of the specified 

number of items where the arrow is pointing to, e.g. The Combi Banks contains 4 to 14 individual 

Combi Banks (depending on the workstation model), and a Combi Bank contains 128 Combis. A 

dashed arrow means that the source is/can be assigned to where it points to (e.g. a combi is assigned 

to a combi category and combi subcategory (latter depends on the workstation model). The default 

number is 1 (so this is optionally displayed). 

4.1.2 Program 

A program is built up from one (Single) or two (Dual) oscillators (and optionally uses a drum kit). A so 

called sampled program is a program which is using one or more of the (multi)samples and a 

modeled program is (normally) not using multi samples, but uses an external board for sound 

production. 
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Examples of sampled programs are programs using the HI, EDS or HD1 rompler engines. 

Examples of modeled programs are programs using the Moss (Korg Triton), Radias (Korg M3), or one 

of the EXIs (Korg Oasys, Korg Kronos). 

Each program has parameters. Only a small portion of parameters are used within PCG Tools, e.g. the 

Name, Favorite setting, Category, Sub category. 

4.1.3 Program Bank 

A program bank always contains exactly 128 programs, indexed from 0 to 127 (except for GM banks 

which are indexed from 1 to 128). A program bank is named with a letter A to N or I-A to I-G, U-A to 

U-G, U-AA to U-GG, depending on the workstation model. The I stands for Int(ernal bank) and the U 

for User (bank). 

A program can be identified uniquely together with its index, e.g. Program I-A64 or I-A064 means 

program number 64 in program bank I-A. 

A program bank can be one of the following two types: modeled or sampled. Most workstations 

program banks are of the sampled type, meaning it contains only sampled programs. Other banks are 

modeled program banks and contain only modeled programs. On some workstation models the 

banks are predefined (meaning a bank can contain sampled programs and never can contain others), 

on other workstation models (like the Oasys and Kronos), each bank can be assigned to contain 

either sampled programs or modeled programs. However, sampled and modeled programs can never 

be mixed within one program bank. 

Also each workstation has one or more GM (General MIDI) banks. These banks are read only and 

therefore are never stored in a PCG file. However, combinations and set list slots can refer to GM 

programs and will be used in PCG Tools whenever necessary, but their names will not be shown 

(since these are not present in PCG files).  

[WARNING]: No difference between different GM banks is made. All GM banks are "mapped" within 

PCG Tools internally to GM (instead of GM, g(1) .. g(9)) for visualization. However, internally (in the 

PCG file) the GM program references will not be changed. 
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 Table 11 shows which workstation models has which program banks and from which type. 

Workstation 
Model 

Sampled 
Program 
Banks 

Sample 
Engine 

Modeled 
Program 
Banks 

Model 
Engine(s) 

Combi 
Banks 

Remarks 

Korg Kronos / 
Korg Kronos X 

I-A..I-F,  
U-A..U-G, 
U-AA..U-
GG 

HD1 I-A..I-F,  
U-A..U-G,  
U-AA..U-
GG 

EXi I-A..I-G 
U-A..U-G 

Each program 
bank can be of 
either type. 

Korg Oasys I-A..I-F,  
U-A..U-G 

HD1 I-A..I-F, U-
A..U-G 

EXi I-A..I-G,  
U-A..U-G 

Each program 
bank can be of 
either type. 

Korg M3 I-A..I-E,  
U-A..U-G 

EDS I-F EXB-
Radias 

I-A..I-G,  
U-A..U-G 

 

Korg M50 A-E EDS n.a. n.a. A-D  

Triton 
Extreme 

A-E,  
H..M 

HI2 F EXB-MOSS A-E,  
H-M 

 

Triton Studio INT-A.. 
INT-E, 
EXB-A.. 
EXB-G 

HI2 INT-A..  
INT-F 

EXB-MOSS INT-A..INT-E, 
EXB-A..EXB-
G 

See * 

Triton Classic A-E HI2 F EXB-MOSS A-D  

Triton 
TR/Rack 

A-E HI2 F EXB-MOSS A-D  

Triton LE A-D HI2 n.a. n.a. A-C  

Karma A-E  F EXB-MOSS A-F  
Table 11: Program Banks from various workstation models 

* The internal banks of Triton Studio are in PCG Tools noted as I-A..I-E instead of INT-A..INT-E 

because PCG files from the Triton Studio cannot be differentiated from the Triton Classic/TR/Rack. 

Not all program banks have to be filled. 

When saving a PCG file on a workstation, per program bank you can select if it will be saved in the file 

or not. Default all program banks will be selected for saving. 

In PCG Tools a program bank is considered empty when all programs in a bank are empty or have an 

initialized name. 

4.1.4 Program Banks 

Program banks are the complete set of all program banks described in the previous paragraph. In  

Table 11 can be found how many and of which type and name are available per workstation model. 

4.1.5 Combi 

A combi is normally used for stacking sounds, splitting the keyboard (or external keyboards) in both 

velocity ranges and keyboard zones and controlling other keyboards.  

Each combi has parameters. Only a small portion of parameters are used within PCG Tools, such as 

the Name, Favorite setting, Category/Sub category. 
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A combi is considered broken, if one or more of the used timbres assigned to an incorrect program, 

which can happen after (unintentionally) overwriting or copy/pasting a program over a program 

being used in that combi. 

4.1.6 Timbres 

A combi consists of 8 or 16 timbres, depending on the workstation model. A combi can be on or off, 

if used (on), it can set to control an external MIDI device, or (normally) it is assigned to a program. 

[EXAMPLE]: If you want to stack sounds, you can assign two (or more) timbres to programs. You also 

can split your keyboard because each timbre has a key zone, so you can define one timbre to be 

active from key C-1 to C4 and another timbre to be active from C#4 to G9. Also it is possible to set a 

velocity range and multiple other parameters, making possibilities endless. 

4.1.7 Timbre 

A timbre refers to a program contained in a program banks, or to an external keyboard/synthesizer 

program. Because a timbre only refer to program (and not containing all parameters of a program), it 

means that changing programs causes to change also the (timbres in the) combis were those 

programs are used in. This has both advantages and disadvantages, see Table 12. 

Advantages Disadvantages 

When a program is improved or changed to your 

likings, all combis using that program automatically 

will use the improved program. 

When changing a program in a combi without 

affecting other combis, you have to copy the 

program to another location and change the 

reference in the combi to the new location. 

Less memory is necessary to store programs.2  

Table 12: Programs referring by combis advantages/disadvantages 

Another disadvantage, not because of the fact that programs are inside combis or referring to 

programs in program banks, is that there is no easy means to know IF and by which combis a specific 

program is used. Luckily, PCG Tools can create a list to solve this problem. 

Of course not all timbres in a combi have to be used (unused timbres can be switched off). 

4.1.8 Combi Bank 

Combi banks are the same as Program banks except they contain combis. Korg workstations mostly 

have 4 to 16 of them, and are named equally as program banks, although they are not related. 

A combi bank always contains 128 combis, indexed from 0 to 127. A combi can be identified uniquely 

together with the combi bank where it resides, e.g. Combi I-A64 or I-A064 means combi number 64 

in combi bank I-A. The I stands for an Int(ernal) bank, as opposed to U(ser) bank. 

Not all combi banks have to be filled. 

                                                           
2
 Having 14 banks of 128 combis containing 16 programs would be 28,672 programs needing to be stored, 

resulting in a PCG file of hundreds of MBs. 
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When saving a PCG file on a workstation, per combi bank you can select if it will be saved in the file 

or not. Default all combi banks will be selected for saving. 

In PCG Tools a combi bank is considered empty when all combi in a bank are empty or have an 

initialized name. 

4.1.9 Combi Banks 

Combi banks are the complete set of all combi banks described in the previous paragraph. In Table 

11 can be found how many are available and their names per workstation model. 

[WARNING]: When saving combi banks using non factory programs always make sure all used 

program banks are saved in the PCG file too. Otherwise when the PCG file is loaded, the references 

to the programs will refer to unexpected programs (causing so called broken combis). 

4.1.10 Set List Slot [Kronos Only] 

The Korg Kronos has introduced a new feature, called set lists. A set list slot is a reference to one 

program or one combi together with a user defined name, a description of 512 characters and a 

volume. 

4.1.11 Set List [Kronos Only] 

128 Set list slots are combined in a Set List. A set list also can have a name and an equalizer setting. 

4.1.12 Set Lists [Kronos Only] 

The Korg Kronos has 128 set lists (each containing of 128 set list slots), resulting in a total of 16,384 

set list slots in total.  

A set list slot is in PCG Tools unique identified as e.g. 034/123, meaning set list slot 123 of set list 34. 

4.1.13 Global 

On each Korg workstation there is always exactly one global section in a workstation. It contains the 

generic data over all programs, combis and set list slots like current MIDI channels, keyboard 

velocity/aftertouch curves, some controller settings, the categories and sub categories etc. 

When saving a PCG file the global section can be saved optionally. Default it is selected to be saved. 

4.1.14 Category 

Each program or combi (not set list slots) is assigned to a category, which can be seen as groups of 

sounds, like piano, organs, drums etc. There are 16 or 18 of them (depending on the workstation 

model, some are empty/unused by default). Each category has a default name, but can be 

overridden in the global section (it is advised not to change the predefined category names). 

[WARNING]: When a PCG file does not contain the global section (see paragraph 4.1.13), category 

names are unknown and the index of the category is used in PCG Tools. 

4.1.15 Sub Category 

Each program or combi (not set list slots) is assigned in a sub category, which depends on the 

category. For each category there are 16 sub categories defined (some are empty/unused by 

default). E.g. the piano category has sub categories Acoustic Piano, Electric Piano, All, etc. 
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[WARNING]: When a PCG file does not contain the global section (see paragraph 4.1.13), sub 

category names are unknown and the index of the sub category is used in PCG Tools. 

4.1.16 Drum Kits 

Drum kits (settings) are also stored in a PCG file, however these are unused by PCG Tools and 

therefore not explained further here. 

4.1.17 Wave Sequences 

Wave sequence (settings) are also stored in a PCG file, however these are unused by PCG Tools and 

therefore not explained further here. 

4.2 Song (SNG) Files 
Song files are files were the songs for the sequencers are stored in. In general, songs contain all notes 

and controller data including used timbres/tracks information. These timbres are very similar to the 

timbres of a combi (see paragraph 4.1.6). Also a list of used samples are contained in a SNG file. 

4.3 KMP/KSF/KSC Files 
These files are used to store (user) samples and are not used by PCG Tools and not further explained 

here. 
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5 Workflow 
PCG Tools can load PCG files or SNG files.  

To get the workstation content into PCG Tools the workflow is described below. 

The workflow for the Korg Kronos with OS2.0 or later and Kronos X is different than for other 

workstations because it can make use of an FTP connection. To setup up an application and create 

the connection see Chapter 11. The steps for using PCG Tools assuming the FTP connection is active 

are: 

 Save a PCG and/or SNG file to the SSD. 

 Download the file on your computer using an FTP program. 

 Optionally make a backup. 

 Open the file in PCG Tools. 

 Continue opening files if wanted (e.g. if you want to copy files from one PCG file to another). 

 Perform actions on the PCG Tools. When the content of the PCG file changes, an asterisk will 

be shown next to the file name in the window title bar. (Currently, SNG file cannot be 

changed). 

 If the contents have changed, it is assumed the file should be saved. It can be saved over the 

original PCG / SNG file or it can be saved to a different file (name) and location. 

 When finished, save the file to your computer. 

 Upload this file to the SSD. 

 Load the file from the SSD. 

The workflow for other workstations and Kronos workstations before OS2.0: 

 Save a PCG and/or SNG file on the workstation by selecting the Save PCG or Save SNG option. 

Depending on the workstation type it can be stored on a CompactFlash (CF) card, 

SecureDigital (SD) card or USB stick/drive. 

 Insert the media in the computer. 

 Optionally copy the file to the computer. 

 Open the file in PCG Tools. 

 Continue opening files if wanted (e.g. if you want to copy files from one PCG file to another). 

 Perform actions on the PCG Tools. When the content of the PCG file changes, an asterisk will 

be shown next to the file name in the window title bar. (Currently, SNG file cannot be 

changed). 

 If the contents have changed, it is assumed the file should be saved. It can be saved over the 

original PCG / SNG file or it can be saved to a different file (name) and location. 

 When finished, copy the file to the media (if not already saved over it if you loaded the file 

directly from the media). 

 Insert the media in your workstation. 

 Load the media in the workstation by selecting the Load PCG or Load SNG option. 
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It is advised to not do too many changes. Regularly save the file and check on the workstation if the 

content is exactly as intended. Always keep a backup before you change information in a PCG file 

with PCG Tools. 
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6 Main Screen 

6.1 Splash Screen 
Before the main screen is shown, a splash screen is visible for approximately five seconds. This screen 

shows the current version, a copyright note, the developer and the (nick) name and optionally a logo 

of the sponsors of the application. In case you are interested in the logo, you always can check out 

the External Links window (see paragraph 6.8.3). The name of the donator which is shown varies 

each time the application is started, and the amount of money donated defines the ratio of being 

displayed. 

 

Figure 5: Splash screen 
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6.2 Initial screen 
When the application is started a screen (somewhat) similar to Figure 6 is shown. 

Figure 6: Initial main screen 

Initially no file is loaded and an mainly empty screen is shown.  

The title of the window contains the application name (PCG Tools), the version, copyright mark/year 

and the name of the developer. 

Furthermore, only the menu and toolbar is shown. Only commands which can be executed are 

selectable, items that cannot be executed are grayed out. 

In the following paragraphs the common menus are explained. 

6.3 File Menu 
The file menu is used for opening, closing files and more basic functionality for the application (like 

closing). 

6.3.1 Open File Command 

This command is used for opening a new PCG of SNG file. 

The following ways can be used to select this command: 

 Select the Open menu item in the File menu 

 Press Ctrl + O key 

 Select the Open file tool bar icon (yellow folder with the green arrow) 

When selected, an Open File dialog will be shown. Here the type of file can be selected, which is one 

of: 
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 PCG files (*.pcg): Load one or more PCG files. 

 SNG files (*.sng): Load one or more SNG files. 

 All files, show all files 

When selecting/changing the type only those type of files are shown. It is possible to select more 

than one file. 

After selecting a (PCG) file, the screen looks like Figure 7.  

 

Figure 7: Opened File 

[TIP]: If you always want start with the same PCG file, pass it as an argument and it will be opened 

automatically when starting PCG Tools. 
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When the file is corrupted or a file is tried to be load from a non supported Korg model an error will 

be shown as shown in Figure 8.  

 

Figure 8: Corrupted or Unsupported File 

In case the PCG file contains no programs, no combis and no set list slot the following warning is 

shown, after which an empty PCG window will be presented. 

 

Figure 9: Empty PCG File 

6.3.2 Save File Command 

This command is used for saving a changed PCG of SNG file. 

The following ways can be used to select this command: 

 Select the Save menu item in the File menu 

 Press Ctrl + S key 

 Select the Save file tool bar icon (the blue disk without the label) 

Changes made by the application are not automatically stored. You have to save them explicitly. 
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Saving a file is only possible if you have really changed the contents. This can be seen at the asterisk 

(*) that is added behind the file name in the window, in the example in Figure 10 the asterisk is 

placed after D:\Kronos.PCG after moving a program down. 

Remember that files shown with an asterisk are NOT saved yet. It is good practice to save regularly. 

 

Figure 10: Changed PCG file 

The file is saved over the loaded file and the asterisk is removed after saving. 

6.3.3 Save (File) As Command 

This menu command is similar to saving a file, except that it is always available (when a file is 

selected).  

The following ways can be used to select this command: 

 Select the Save As menu item in the File menu 

 Press Ctrl + Shift + S key 

 Select the Save As file tool bar icon (blue disk with the white label) 

When selected, a save file dialog is shown and a name can be entered or a file to overwrite to can be 

selected for saving the file.  

[WARNING]: There is no Undo functionality, after saving a file you cannot return to an earlier state, 

but you can regularly save files under different names to be able to go back to a certain file if needed. 
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6.3.4 Export to Sequencer Command 

This menu command will be handled in Paragraph 7.6.1). 

6.3.5 Revert to Saved Command 

This command is used for reverting to the saved file. 

 The following ways can be used to select this command: 

 Select the Revert To Saved menu item in the File menu 

When selected, the selected file is reloaded. This should be used with care, because all changes since 

the last time the file was saved will be undone and cannot be redone. 

You can use this function as a Undo feature to restore the status to the last saved situation. 

When a cut/paste or copy/paste action is in progress while executing this command, Figure 37 will be 

shown to ask whether to continue or not. Continuing might result in partly copied patches. 

[TIP]: when you have saved a file, changed it on your workstation and saved the PCG file on the 

media and inserted that media into your computer again in the same folder and under the same 

name, to load that changed file in PCG Tools, it is not needed to close the selected file and open the 

same file again, but a simple 'Revert to Saved' command will do. 

[TIP]: When too many Combi windows (see paragraph 7.4) are open, this command can be used to 

close all Combi windows from this PCG file. Also all bank and patch selections (highlighted banks and 

patches) are discarded, because the file is closed and reopened again. 

6.3.6 Close Command 

This command is used for closing the selected PCG or SNG file. 

The following ways can be used to select this command: 

 Select the Close menu item in the File menu 

 Press Ctrl + F4 key (default Windows behavior) 

When selected, the selected file is closed. In case the file has been changed without saving (shown by 

the asterisk), a warning message is shown to save the file or not as shown below. 

 

Figure 11: Warning Dialog when closing a changed file 
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When a cut/paste or copy/paste action is in progress while executing this command, Figure 37 will be 

shown to ask whether to continue or not. Continuing might result in partly copied patches. 

For PCG files, when sub windows are shown (such as the Combi window explained in Paragraph 7.4), 

all sub windows are closed automatically. 

When a window is closed the size is remembered and the next time a window of the same type is 

opened, automatically those dimensions will be used. The different window types are: 

 PCG Window 

 Combi Window 

 SNG Window 

6.3.7 Exit Command 

This command is used for exiting the application. 

The following ways can be used to select this command: 

 Select the Exit menu item in the File menu 

 Press Alt + F4 key (Default Windows behavior) 

When selected, the application is stopped. All opened files are closed and for every unsaved changed 

files is asked whether it should be saved or not (as explained in paragraph 6.3.6). One extra option is 

available in case a file is changed but unsaved: Cancel. When selecting this option, the application 

does not exit and no more files are closed. See below for an example of this warning dialog. 

 

Figure 12: Warning Dialog when exiting PCG Tools 

When a cut/paste or copy/paste action is in progress while executing this command, Figure 37 will be 

shown to ask whether to continue or not. Continuing might result in partly copied patches. 
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6.4 Edit Menu 
This menu shows actions depending on the current window that is shown and can be found in the 

corresponding window explanation. 

6.5 Show Menu 

6.5.1 Timbres  

Timbres is only active when in a PCG window a single combination is selected. With this command a 

new window is displayed, showing the timbres of the selected combi. See Paragraph 7.4 for more 

info. 

6.5.2 Special Event 

This menu item is not always enabled, only when a special announcement or event has occurred. 

Below is an example. 

 

Figure 13: Special Event 

 

 

6.6 Theme Menu 
This menu shows three different types of GUI Skins that can be used for showing files: 

 Generic (Pre Windows XP Theme), see Figure 14. 

 Luna (Windows XP Theme), see Figure 15. 

 Aero (Windows Vista/Windows 7 Theme), see Figure 16. 
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Figure 14: Generic Theme 

 

 

Figure 15: Luna Theme 
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Figure 16: Aero Theme 

6.7 Options Menu 

6.7.1 Settings 

This window shows currently the cut/copy/paste settings. For more info, see Paragraph 7.3.7.5.1. 

6.8 Help Menu 
This menu shows the manual and contains info about the application and external links. 

6.8.1 Manual 

This command shows this manual as PDF in your browser. 

The following ways can be used to select this command: 

 Select the Manual menu item in the Help menu 

When selected, your default browser opens a PDF with the manual (same contents as this file). An 

internet connection is needed and the manual is residing at the KorgForums site (thanks to Sharp). 

Note that it can take some time before the manual is loaded in your browser, because it is a 

reasonably big file (about 5 MB). 

6.8.2 About Command 

This command is used for showing generic info about PCG Tools. 

The following ways can be used to select this command: 

 Select the About menu item in the Help menu. 
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 Select the About tool bar icon (white balloon with a blue i). 

When selected, a window is shown like in Figure 17. 

[TIP] If you find this application useful, please consider using the Donate option. 

 

Figure 17: About window  
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6.8.3 External Links Command 

This command is used for opening a new PCG of SNG file. 

The following ways can be used to select this command: 

 Select the External Links menu item in the Help menu. 

When selected, external links are shown which can be opened by the default browser as in Figure 18. 

These links are either Korg related and/or are links from users who have donated. See Table 13 and 

Table 14 for all available links. 

Korg Related 

Icon / Title Web Site Description 

PCG Tools http://www.korgforums.com/forum/p
hpBB2/viewtopic.php?t=63765 

Forum thread in korgforums for 
PCG Tools 

PCG Tools for web http://www.korgforums.com/forum/p
hpBB2/viewtopic.php?t=68526 

Location for the web based 
forum thread of PCG Tools for 
Web 

Korg http://www.korg.com Company Korg 

Korg Forums http://www.korgforums.com The largest forum for Korg users 

Kid Nepro http://www.kidnepro.com/KN/Korg/K
org.html 

Sounds for various Korg models. 

Korgpatches http://www.korgpatches.com Collection of Korg PCG files for 
various Korg models. 

Kronos Haven http://www.kronoshaven.com Information site for the Korg 
Kronos 

Robert Rosen http://robertrosen.weebly.com Collection of Korg PCG files for 
various Korg models. 

Onksor http://www.arweiler.onlinehome.de/
onksor.html 

Korg Kronos WYSIWYG Setlist 
Organizer application 

Kronoscopie (French) http://www.kronoscopie.fr  Korg Kronos website in French 
language. 

Karo Sound 
Development 

http://www.karo-sounds.com Sounds for Korg Kronos and 
other Korg workstations. 

Kronos-mw.com http://kronos-mw.com/ Korg Kronos website in French 
language. 

Muziekhuis Lyana http://www.lyana.nl Dutch music store. 

Korg Kronos AL-1 Editor http://www.chrutil.com/kronos Third party application for Korg 
Kronos, AL-1 editor. 

Table 13: Korg Related External Links 

http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=63765
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=68526
http://www.korgforums.com/forum/phpBB2/viewtopic.php?t=68526
http://www.korg.com/
http://www.korgforums.com/
http://www.kidnepro.com/KN/Korg/Korg.html
http://www.kidnepro.com/KN/Korg/Korg.html
http://www.korgpatches.com/
http://www.kronoshaven.com/
http://robertrosen.weebly.com/
http://www.arweiler.onlinehome.de/onksor.html
http://www.arweiler.onlinehome.de/onksor.html
http://www.kronoscopie.fr/
http://www.karo-sounds.com/
http://kronos-mw.com/
http://www.lyana.nl/
http://www.chrutil.com/kronos
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Others 

Icon / Title Web Site Description 

Dreamland Recording 
Studio 

http://www.dreamland-recording.de/ Dreamland recording studio in 
Marburg, Germany 

Keller12  http://www.keller12.de German Electro-Rock Fun-Pop 
Formation.  

The Supernatural 
Heroes (Belgian) 

http://www.thesupernaturalheroes.c
om/ 

Belgium allround coverband 

Toon Martens Project 
(Belgian) 

http://www.toonmartensproject.net/ Progressive rock band 

Cyber-tek.pl http://www.cyber-tek.pl/ PC Service & Repair 
Table 14: Other External Links 

Figure 18 shows a screen shot of all external links. 

 

Figure 18: External Links 

6.8.4 Oasys Codes Sponsors 

Some persons donated part or full of their Korg Oasys voucher codes to Kronos owners, worth up to 

US $750.  

On behalf of every Korg Kronos receiver of such a code, I would like to thank the following persons: 

- Ian Hutty (Ianhu) 

- Patrick Dumas (Fzero) 

- Steve D (steved53) 

- Frans van den Berg (Paulifra) 

http://www.dreamland-recording.de/
http://www.keller12.de/
http://www.thesupernaturalheroes.com/
http://www.thesupernaturalheroes.com/
http://www.toonmartensproject.net/
http://www.cyber-tek.pl/
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- Tim (t_tangent) 

- SoulBe 

- Adam P (Kontrol49) 

For the screenshot, see Figure 19. 

 

Figure 19: Oasys Codes Sponsors 

6.9 Toolbar 
The toolbar can be considered as  a set of icons, functioning as short cuts for the menu (or controls 

like buttons) on the different screens. The most important commands are gathered in the toolbar 

and also are mentioned in the activation of the commands. 
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7 Using PCG Files 

7.1 Introduction 
This chapter is the main chapter of this manual, since it contains all explanation how to handle with 

PCG files in PCG Tools. 

7.2 Status Bar 
When a PCG file is opened the status bar shows a lot of information as shown in Figure 20. 

 

Figure 20: Status Bar 

The meaning and color of these items is shown in Table 15. 

Item Description Color 

Korg Kronos Model of the Korg workstation (called workstation model) and if 
applicable, the PCG/OS version, see next paragraph. See * 

Black 

PCG Type of file (PCG or SNG) Green 

1797 programs in 
19 banks 

Total of 1797 programs in 19 program banks, empty or initialized 
programs are not counted. 

Blue 

501 combis in 7 
banks 

Total of 501 combis in 7 combi banks, empty or initialized combis are 
not counted. 

Blue 

142 set list slots in 4 
set lists 

Total of 142 set list slots in 4 set lists, empty or initialized set list slots 
are not counted. 

Blue 

Clipboard Shows the number of programs, combis and set list slots that are 
present in the cut/copy/paste clipboard. 

Red 

Table 15: Status Bar Items 

*Since most Korg Triton family PCG files cannot be differentiated, an active PCG file for the Triton is 

either showing 'Triton Extreme', 'Triton Classic/Studio/Rack' or 'Triton LE'. Other workstation models 

that are displayed can be Kronos (X), Oasys, M3, M50 and Karma. 

When multiple PCG files are opened, the status bar shows the information of the selected PCG file 

(window). 

7.2.1 PCG/OS Version 

The PCG/OS version is displayed only for those workstation models in combination with PCG/OS 

versions where the difference is important. These are the following: 

 Korg Kronos version 1.0/1.1 

 Korg Kronos version 1.5/1.6 

 Korg Kronos (X) version 2.0 

 Korg M3 version 1.x 

 Korg M3 version 2.0 (expanded) 
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7.3 PCG Window 

7.3.1 Introduction 

When a PCG file is opened a window is shown, a so called PCG window. In Figure 21 such a window is 

shown.  

 

Figure 21: PCG Window 

When a PCG window is made smaller, the controls on the window are automatically wrapped. This is 

ideal for users with a small screen. See Figure 22 for an example. 
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Figure 22: Wrapped PCG Window 

In the following paragraphs each item of a PCG Window is explained in more detail. 

7.3.2 Title 

The title of a PCG window is the name of the PCG file including its path, in this case d:\Kronos.pcg. 

An asterisk is shown when the file is changed as an effect of one of the commands explained later. 

7.3.3 Programs/Combis/Set Lists Radio buttons 

These three radio buttons can be used for selecting programs, combis or set lists.  

[KRONOS ONLY]: Only when a Kronos PCG file is loaded, the Set Lists radio button is shown. 

7.3.4 Banks Listview (Left side) 

A PCG window has two list views, one on the left and one on the right. The left list view is called the 

Banks Listview and contains the program banks, combi banks or set lists, depending on the radio 

button above. 

7.3.4.1 Program Banks 

When program banks are selected, the content type of each bank is shown. There are two different 

kinds: 

 Modeled Programs: These are program banks with modeled programs, e.g. from an EXi 

(Kronos/Oasys), Radias (M3) or MOSS (Tritons). 

 Sampled Programs: These are programs banks using samples, e.g. from the HD1 engine 

(Kronos/Oasys), EDS engine (M3, M50) or HI engine (Tritons, Karma). 

A program bank only can contain programs of either modeled types or sampled types. 
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The GM banks are not shown because GM banks are not contained in a PCG file. 

7.3.4.2 Combi Banks 

Combi banks do not have additional information shown per bank. 

7.3.4.3 Set Lists [KRONOS ONLY] 

When set lists are selected, the ID (0-128) of the set list is shown and the name of the set list. 

7.3.5 Patches Listview (Right side) 

The right list view shows the patches, depending on whether programs, combis or set lists are 

selected and which bank has been selected. Only the patches shown from the first selected bank in 

the Banks Listview are shown. 

7.3.5.1 Programs/Combis 

When a program or combi bank is selected, the following information is shown per program/combi: 

 ID: the unique ID of the program or combi, e.g. I-C124. 

 Name: The name of the program or combi, e.g. "The Log Drum". 

 Fav: Shows an asterisk if the program/combi is selected as favorite. [KRONOS ONLY] 

 Category: Shows the category where the program/combi is assigned to. 

 Sub Category: Shows the sub category where the program/combi is assigned to. 

7.3.5.2 Set List Slots [KRONOS ONLY] 

When a set list is selected, the following information is shown per set list slot: 

 ID: the unique ID of the set list slot in format <set list>/<set list slot>, e.g. 024/037 means set 

list 37 inside set list 24. 

 Name: The name of the set list slot. 

 Ref: The reference of the set list slot: can be either a program or combi, examples are Prg I-

A000, Cmb I-A003 etc. 

 Program/Combi name: The name of the referenced ID, e.g. "Stradivarious Sync". 

 Description: The text that can be assigned to a set list slot. 

7.3.6 Generic Commands 

Below the banks and patches list, the buttons for all commands are shown. These buttons have a 

different meaning depending on whether banks are selected or patches (i.e. the Banks Listview or 

the Patches Listview). Which list is selected, can be seen by the thick grey border around the current 

selected list. 

One or multiple items in a list can be selected. Some commands only can be activated when one or 

more banks are selected, some commands only when one or more patches are selected, and some 

can be selected in either list. This will be shown in the activation prerequisite in each command 

paragraph. 

The second row of buttons are the cut/copy/paste buttons. 

[WARNING]: Most commands cannot be undone, be especially careful with the Edit, Clear and 

Compact commands. 
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7.3.6.1 Edit Command 

This command can be used to change certain parameters of the selected patch. Depending on the 

type (program, combi or set list) a different dialog is shown. 

Activation prerequisite: select exactly one patch in the patches list. 

The following ways can be used to select this command: 

 Select the Edit menu item in the Edit menu 

 Select the Edit tool bar icon in the tool bar (white document with the green pencil) 

 Click the Edit button 

 Double clicking on a patch 

 Press F2 key 

 Press Alt-e until the Edit button is highlighted and press Enter 

7.3.6.1.1 Edit Program 

When a program is selected, the dialog in Figure 23 is shown. 

 

Figure 23:  Edit Program 
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Table 16 shows what info is shown and can be changed. 

Item Type Description 

ID Read only Unique ID of the program. 

Name Editable Name of the program including the current and 
maximum number of characters that can be used. 
The maximum number of characters depends on 
the workstation model. 

Is Favorite Editable Selects whether the program is set as favorite or 
not. [KRONOS (X) ONLY] 

Category  Editable Category of the program. 

Sub Category  Editable Sub category of the program. 
Table 16: Edit Program Items 

PCG files optionally contain the Global part, which contains the names of the categories and sub 

categories. If the Global part is available, the names of categories and sub categories are shown in 

the two combo boxes shown in Figure 23, if not the index numbers are shown. 

If you try to enter a name that is too long (the maximum length depends on the workstation model),  

the error 'Name too long' is shown in red (see Figure 24) and the OK button will be disabled. 

 

 

Figure 24: Program Name too long 

7.3.6.1.2 Edit Combi 

Editing a combi works exactly like editing a program (see Paragraph 7.3.6.1.1). 

7.3.6.1.3 Edit Set List Slot [KRONOS ONLY] 

When a set list slot is selected, the dialog in Figure 25 is shown. 
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Figure 25: Edit Set List Slot 

 

Table 16: Edit Program ItemsTable 17 shows what info is shown and can be changed. 

Item Type Description 

ID Read only Unique ID of the program. 

Name Editable Name of the set list slot including the current and 
maximum number of characters that can be used.  

Description Editable Description of the set list slot including the current 
and maximum number of characters that can be 
used. 

Table 17: Edit Set List Slot Items 

If you try to enter a name or description that is too long (the maximum length depends on the Korg 

model),  the error 'Name too long' or 'Description is too long' is shown in red (see) and the OK button 

will be disabled. See Figure 26 for an example of a description that is too long. 
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Figure 26: Set List Slot Description Too Long 

For the name and description, the character set that can be used is equal to the character set of the 

on screen keyboard of the Kronos. However, for descriptions it is possible to enter linefeed/return 

characters, which will also cause a linefeed/return to be shown in the Kronos display. A 

linefeed/return character costs 2 characters instead of one. When changing the description text on 

the Kronos the linefeed/return characters, the cursor will be misaligned, so it is best to use this dialog 

screen for editing descriptions. 

When returning to the PCG Window (after closing the Edit screen), when using line feeds/returns the 

set list slots look like (after selecting several set list slots). 

 

Figure 27: Set List Slots with Line Feeds/Returns 
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7.3.6.2 Move Up Command 

This command moves the selected patch one position up. 

Activation prerequisite: select exactly one patch (not the first patch) in the patches list.  

The following ways can be used to select this command: 

 Select the Move Up menu item in the Edit menu. 

 Select the Move Up tool bar icon in the tool bar (blue half arrow pointing up) 

 Click the Up button. 

 Press the up cursor key on the numeric keyboard (on the 8 key). 

 Press Alt-u until the Up button is highlighted and press Enter. 

When moving a program, all combis and set list slots referring to the selected program (and 

programs moved down to let the selected programs move up) are changed accordingly. 

When moving a combi, all set list slots referring to the selected combi (and combis moved down to 

let the selected combis move up) are changed accordingly too. 

7.3.6.3 Down Command 

This command moves the selected patch one position up.  

Activation prerequisite: select exactly one patch (not the last patch) in the patches list.  

The following ways can be used to select this command: 

 Select the Move Down menu item in the Edit menu. 

 Select the Move Down tool bar icon in the tool bar (blue half arrow pointing down) 

 Click the Down button. 

 Press the Down cursor key on the numeric keyboard (on the 2 key). 

 Press Alt-d until the Down button is highlighted and press Enter. 

When moving a program, all combis and set list slots referring to the selected programs (and 

programs moved down to let the selected programs move up) are changed accordingly. 

When moving a combi, all set list slots referring to the selected combis (and combis moved up to let 

the selected combis move down) are changed accordingly too. 

7.3.6.4 Clear Command 

This command clears or erases the selected patches or all patches in the selected banks.  

Activation prerequisite: select one or more banks or one or more patches. 

The following ways can be used to select this command: 

 Select the Clear menu item in the Edit menu. 

 Select the Clear tool bar icon in the tool bar (blank page) 

 Click the Clear button. 

 Press Alt-c until the Clear button is highlighted and press Enter. 
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This command behaves differently depending on whether the banks or patches list is active. 

When banks are active, all patches in the selected banks will be cleared. When patches are active, 

only all selected patches will be cleared. 

Clearing a patch is not equal to initializing them.  

Clearing a program means: 

 Clearing the name (empty name). 

 Setting the category (and if supported sub category) to the first category/sub category. 

 Deselect the Favorite setting [KRONOS (X) ONLY] 

[WARNING]: When clearing programs, combis/set list slots using those programs are not broken, but 

it will not be trivial that empty programs are still used by combis/set list slots. 

Clearing a combi means: 

 Clearing the name (empty name). 

 Setting the category and sub category to the first category/sub category. 

 Deselect the Favorite setting 

 Clearing the most important parameters of all timbres in thecombi: 

o Program set to I-A000 / A000 (depending on the workstation model). 

o Status set to Off. 

o Muted. 

o Volume set to 0. 

o MIDI Channel set to 16. 

o Bottom/Top key set to the lowest key. 

o Bottom/Top velocity set to 0. 

o Osc Mode set to Mono. 

o Osc Select set to OSC2. 

o Transpose set to 0. 

o Portamento set to 0. 

o Bend Range set to 0. 

[KRONOS ONLY]  [WARNING]: When clearing combis, combi parameters are changed and set list 

slots using these cleared combis will not be audible anymore (equal to the cleared combis). 

[KRONOS ONLY] Clearing a set list slot means: 

 Clearing the name (empty name). 

 Clearing the description (empty description) 

 Set the reference to program I-A000. 

 Setting the category and sub category to the first category/sub category. 

Figure 28 shows the result of clearing the selected patches. 
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Figure 28: Clear Command 

[TIP]: The reason to clear/empty the names instead of giving them a initialized name (e.g. INIT 

PROGRAM I-A030) is that emptying them shows in a glance that those patches are empty. If you 

want to create a new sound, initialize the patch on the workstation to start from a 'real' initialized 

patch . 

[TIP]: A quick way to remove patches you don't like is to load the PCG file that is currently in your 

workstation, audition patches on your workstation and if you find one or more patches, select them 

in PCG Tools and clear them. Do not make changes on your workstation. When finished, save the PCG 

file and load it in your workstation. 

 

[TIP]: After clearing patches, there might be gaps with empty patches within your bank(s). Consider 

to use the Compact command to remove these empty gaps. 

[TIP]: Note that deleting a patch is not possible, since there are always 128 patches in a bank (or set 

list). What comes most close to deleting a patch is to clear a patch, and then use the Compact 

command to move the cleared patch to the bottom. 
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7.3.6.5 Compact Command 

This command moves all empty or initialized patches down and all filled patches up. 

Activation prerequisite: select one or more banks or at least two patches. 

The following ways can be used to select this command: 

 Select the Compact menu item in the Edit menu. 

 Select the Clear tool bar icon in the tool bar (blank page) 

 Click the Compact button. 

 Press Alt-c until the Compact button is highlighted and press Enter. 

Compacting should be used to remove the gaps that exist after clearing patches or when patches are 

splintered over a bank. 

This command behaves differently depending on whether the banks or patches list is active. 

When patches are active, only all selected patches will be compacted. In Figure 29 several set list 

slots have been selected and some of them are empty. When the Compact command is used, all set 

list slots (also those which are initialized or empty) are moved up within the selection. Set list slots 

that are not selected are left alone, thus not moved. In Figure 30 the result is shown after 

compacting. 

 

Figure 29: Before Compacting 
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Figure 30: After Compacting 

If multiple program banks are selected and the selection contains both modeled program banks (EXi, 

Radias, Moss) banks and sampled program banks (HD1, EDS), the banks are split into two sets and 

both sets are compacted separately (as if you would first select only the modeled program banks and 

compact them and then select the sampled program banks and compact them). 

Also when selecting multiple banks, compacting them is not performed per bank. E.g., if two banks 

are selected and the first selected bank contains 20 empty patches, then 20 patches from the second 

selected bank (if not empty) are moved to the first selected bank. 

[TIP]: To create empty banks, first remove unwanted patches by clearing them, then select all banks 

and compact all banks. The result is (depending on the amount of removed patches), that completely 

empty banks are available (which will be the last banks of the sampled/modeled type).  

When moving programs, all combis and set list slots referring to the selected programs (and 

programs moved down to let the selected programs move up) are changed accordingly. 

[KRONOS ONLY] When moving combis, all set list slots referring to the selected combis (and combis 

moved down to let the selected combis move up) are changed accordingly too. 
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7.3.6.6 Timbres Command 

This command is used to manage the timbres inside a combi. 

Activation prerequisite: select exactly one combi. 

The following ways can be used to select this command: 

 Select the Timbres menu item in the Show menu. 

 Select the Timbres tool bar icon in the toolbar (page with green and red controls) 

 Click the Timbres… button. 

 Press Alt-t until the Timbres button is highlighted and press Enter. 

This command shows the timbres of the selected combi. A new window will appear and is explained 

in more detail in Paragraph 7.4. 

7.3.7 Cut/Copy/Paste Commands 

7.3.7.1 Introduction 

Cut / Copy / Paste commands are for moving and copying patches and are also called Copy/Paste 

commands in short. Cut/Copy/Paste patches is unlike cut/copy/pasting text in a text editor (e.g. 

NotePad) a lot more complicated. The reason for this, is that programs are used in combis and set list 

slots and combis are used in set list slots and by copy/pasting combis or set list slots, the underlying 

used patches should also be pasted. 

When combis or set list slots would be copied and pasted without their used programs or combis, 

they would not sound at all or at least not sound as their originals, resulting in so called broken 

combis or set list slots. Therefore, when combis are copy/pasted, all used programs in those combis 

should be pasted too. If set list slots are copy/pasted, all used programs and combis in the copied set 

list slots should be pasted, but also the programs used in the combis used in the copied set list slots.  

Because you need to have control over the location where programs, combis and set lists can be 

pasted, a copy/paste action is not a two step action like in a text editor: copy, then paste. Instead, a 

copy action is performed, and after that one or more paste actions are needed, until all programs, 

combis and set list slots are pasted. 

For cut/paste something similar is true. When moving programs to another location, the 

combinations and set list slots where that program is used in, should be changed accordingly. 

Something similar should occur for moved combinations in set list slots where the moved 

combinations are used in. 

 [WARNING]: Most commands cannot be undone, be especially careful with the Paste command, Exit 

and Recall commands. Check the Cut/Copy/Paste settings (see paragraph 7.3.7.5.1) before starting 

with one or more cut/copy/paste actions. 

7.3.7.2 Copying between different workstation models 

Unlike on the real Korg workstation, there are limitations of patches able to be copied between 

different workstation models. Only workstations within the same PCG Tools Compatibility box 

(shown in the table below) are allowed to be copied between them. 
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Workstation Group PCG Tools Compatibility 

Korg Kronos (X)/Oasys1 
 

Korg Kronos X 
Korg Kronos OS 1.5/1.6 

Korg Kronos OS 1.5/1.6 

Korg Kronos OS 1.0/1.1 

Korg Oasys 

Korg  M family 
 

Korg M3 2.0 

Korg M3 v1.x 

Korg M50 

Korg Triton family / Karma 
 

Korg Triton Extreme 

Korg Triton Studio 
Korg Triton Classic 
Korg Triton TR 
Korg Triton Rack 

Korg Triton LE 

Korg Karma 
 1 Korg Oasys PCG files are only readable on Korg Kronos (X) workstations, not vice versa 

Table 18: Compatible workstation models 

However, if you want to copy patches between two PCG files from different Korg workstation models 

that are incompatible for PCG Tools, there is a solution. Perform the following steps: 

 Find out which (or both) PCG file(s) is (are) not from the same workstation model or current 

operating system of your workstation model. With that file (or those files), perform the 

following steps. 

 Load the PCG file in your workstation. 

 Save the PCG file. This will automatically convert the PCG file in a format equal to your 

workstation model and to the same Operating System version as your workstation model. 

 Load the PCG file in PCG Tools. 

Once a PCG file is converted to your workstation model and latest Operating System version, you do 

not have to do this again. 

7.3.7.3 Cut Command 

This command is used for moving patches, by first cutting them and later patching them to the 

wanted position(s). 

Activation prerequisite: select one or more program banks, combi banks or set lists, or select one or 

more programs, combis and set list slots. Also a current cut/copy/paste action should not be active 

(when the paste operation from a cut/copy action has been started, it should be finished or exited 

before being able to use the Cut command again). 

The following ways can be used to select this command: 

 Select the Cut menu item in the Edit menu. 

 Select the Cut tool bar icon in the toolbar (the pairs of scissors icon) 

 Press Ctrl + X key (default windows Cut behavior) 

 Click the Cut button. 
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This command depends on whether banks or patches are selected, and also depends on the type of 

patches which are cut. All selected patches are copied to the so called clipboard, and also cleared 

(see Clear command). The clipboard is shown in the status bar at the bottom of the PCG Tools screen 

in red. It is not part of the PCG file but serves as a temporary storage for cut and copied patches. 

There is only one clipboard available, when a cut or copy is performed, the clipboard is filled and a 

new cut or copy will overwrite the current clipboard content. 

[EXAMPLE]: When cutting program I-A000 (Kronos Piano), the program will be cleared (shown as an 

empty program). When moving this program to bank U-G, it will be shown there, see below. Note 

that the clipboard is being empty again.  

 

Figure 31: Program after cut and paste 

Also when the timbres window of combi I-A000 is opened, one of the timbres point to U-G020 

instead of I-A000, see below. 
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Figure 32: Clipboard content after copying a set list 

A cut action cannot be used to paste the patches in another PCG file. 

[WARNING]: Take care not to close a PCG file that has patches pasted into it before the clipboard is 

empty, otherwise the non pasted patches are lost.  

7.3.7.4 Copy Command 

This command is used for copying patches, to be pasted later. 

Activation prerequisite: select one or more program banks, combi banks or set lists, or select one or 

more programs, combis and set list slots. Also a current cut/paste or copy/paste action should not be 

active (when the paste operation from a cut/copy action has been started, it should be finished or 

exited before being able to use the Copy command again). 

The following ways can be used to select this command: 

 Select the Copy menu item in the Edit menu. 

 Select the Copy tool bar icon in the toolbar (page with a shadow page behind it) 

 Press Ctrl + C key (default windows Copy behavior) 

 Click the Copy button. 
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This command depends on whether banks or patches are selected, and also depends on the type of 

patches which are copied. All necessary patches are copied to the so called clipboard. The clipboard 

is shown in the status bar at the bottom of the PCG Tools screen in red. It is not part of the PCG file 

but serves as a temporary storage for copied patches. There is only one clipboard available, when a 

copy is performed, the clipboard is filled and a new copy will overwrite the current clipboard content. 

In Fout! Verwijzingsbron niet gevonden. is shown which patches are copied into the clipboard.  

Type Selected Patch type selected What is copied to the clipboard 

Patches Programs - All selected programs. 

Patches Combis - All selected combis. 
- All selected programs by the selected combis. 

Patches  Set List Slots - All selected set list slots. 
- All combis used by the selected set list slots. 
- All programs used by the copied combis above. 
- All programs used by the selected set list slots. 

Banks Program Banks - All programs inside the selected program 
banks. 

Banks Combi Banks - All combis inside the selected combi banks. 
- All programs used by the combis above. 

Banks Set Lists - All set list slots inside the selected set lists. 
- All combis used by the set list slots above. 
- All programs used by the copied combis above. 
- All programs used by the set list slots above. 

Table 19: Cut / Copied Patches 

 [EXAMPLE]: When the Preload Set List is copied (set list 0), not only the set list slot is copied but also 

all used programs and combis and programs used in the combis. See Figure 33 for the resulting 

content in the clipboard: 57 sampled programs, 128 modeled programs, 9 combis and 127 set list 

slots. 

 

Figure 33: Clipboard content after copying a set list 

After a Copy action, all necessary patches are copied to the clipboard and that PCG file can be closed 

without affecting the clipboard.  
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[WARNING]: Take care not to close a PCG file that has patches pasted into it but not the complete 

clipboard is empty.  

7.3.7.5 Paste Command 

This command is used for pasting patches which are present in the clipboard, either by cutting or 

copying. 

Activation prerequisite: select one or more banks or patches. Also the clipboard should be nonempty. 

The following ways can be used to select this command: 

 Select the Paste menu item in the Edit menu. 

 Select the Paste tool bar icon in the toolbar (orange clipboard with a page on it) 

 Press Ctrl + V key (default windows Paste behavior) 

 Click the Paste button. 

This command depends on whether banks or patches are selected and whether a single patch or 

multiple patches are selected. Also, the cut/copy/paste settings affect this command. 

Because pasting patches is not trivial, in paragraph 7.3.7.9 several examples are given how to 

cut/paste and copy/paste. 

Note that after the first paste (i.e. when copying only a portion of the clip board), it is not possible to 

paste to another PCG file until the cut/paste or copy/paste operation is finished. The reason is that if 

you would paste combis to one PCG file and paste the used programs in those combis to another PCG 

file, the combis would not sound correctly (would be broken).  

Cut patches can only be pasted within the PCG they are cut from. 

 

Figure 34: Incompatible Korg workstation model 

Also most commands that can change the order of patches are disabled until the cut/paste or 

copy/paste operation is finished. You can imagine that the results of moving, clearing or compacting 

patches during a cut/paste or copy/paste operation would get very unclear (e.g. what if you cleared a 

program and the combi you have pasted contain that just cleared program?). 

A cut/paste or copy/paste operation is finished as soon as the clip board is empty. If you want to 

force to finish a cut/paste or copy/paste operation, you can use the Cut/Copy/Paste Exit command 

(see Paragraph 7.3.7.7). 
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7.3.7.5.1 Pasting to different workstation models 

It is not possible to paste patches to PCG files from different workstation models. The only exception 

is the Triton family which has compatible PCG files. 

 There are a lot of reasons why this is not possible: The synthesis engine is different, so the 

parameters of one workstation model is different than the other. 

 Even if the parameter is equal, the curve/linearity might be different. 

 The sample sets are different. 

7.3.7.5.2 Pasting to different OS versions. 

In some cases patches cannot be pasted to PCG files from the same workstation model.  

For the Korg Kronos (and Kronos X) patches cannot be pasted between the following versions: 

- Korg Kronos version 1.0/1.1 

- Korg Kronos version 1.5/1.6 

- Korg Kronos (X) version 2.0 

Meaning: a patch from Korg Kronos version 1.1 cannot be pasted into a PCG file from a Korg Kronos 

version 1.5 (or vice versa). 

And Korg M3 patches cannot be pasted between the unexpanded and expanded versions: 

- Korg M3 version 1.x 

- Korg M3 version 2.0 (expanded) 

When trying, you will see the following error: 

 

Figure 35: Incompatible OS version 

However, you can easily work around this, as long as the workstation model is equal: 

 Load the older version in the M3 or Kronos (make a backup of your current PCG file first) 

 Save the file again, then the M3 or Kronos will automatically save it in the latest (current) OS 

version. 

 Revert to the just saved fie. 

 Now copy/paste is possible between the two files. 



Chapter 7 - PCG Files  Paragraph 7.3.7 - PCG Window / Copy & Paste Commands 
 

 
56 

 

7.3.7.6 Cut/Copy/Paste Settings Command 

7.3.7.6.1 Showing the settings 

This commands manages the cut/paste and copy/paste settings. 

The following ways can be used to select this command: 

 Select the Settings menu item in the Options menu. 

 Select the Settings tool bar icon in the toolbar (page with a saw disk) 

 Click the Cut/Copy/Paste Settings button. 

 Press Alt-s until the Cut/Copy/Paste Settings button is highlighted and press Enter. 

Cut/Copy/Paste settings are global for all PCG files, so it does not matter from which PCG file it is 

shown or changed. 

7.3.7.6.2 Settings 

The figure below shows all copy/paste settings including its default settings. 

 

Figure 36: Cut/Copy/Paste Settings 
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Figure 36 shows all default cut/copy/paste settings and Table 20 shows the description of each 

setting.  

Item Default Description 

Copy Incomplete 
Combis 

Off When selected, only combis which have ALL programs present in 
the PCG file will be copied (together with their used programs). 
This cannot result in broken combis. 
 
If not selected, all combis (together with their used programs) 
will be selected. This means combis will be copied that are 
incomplete and can result in broken combis. 
 
This option is ignored when using cut/paste operations. 

Copy Incomplete Set 
List Slots 

Off When selected, only set list slots which have ALL combis and ALL 
programs present in the PCG file will be copied (together with 
their used combis and programs and programs used in the used 
combis). This cannot result in broken set list slots. 
 
If not selected, all set list slots (together with their used 
programs, combis and used programs in used combis) will be 
selected. This can result in broken set list slots. 
 
This option is ignored when using cut/paste operations. 

Paste Duplicate 
Programs 

Off If selected, programs can be pasted even if there are already 
duplicates in the PCG file, otherwise the duplicate programs will 
be automatically removed from the clip board after the first 
paste action to a PCG file. 
 
This option is ignored when using cut/paste operations. 

Paste Duplicate 
Combis 

Off If selected, combis can be pasted even if there are already 
duplicates in the PCG file, otherwise the duplicate combis will be 
automatically removed from the clip board after the first paste 
action to a PCG file. 
 
This option is ignored when using cut/paste operations. 

Paste Duplicate Set 
List Slots 

On If selected, set list slots can be pasted even if there are already 
duplicates in the PCG file, otherwise the duplicate set list slots 
will be automatically removed from the clip board after the first 
paste action to a PCG file. 
 
This option is ignored when using cut/paste operations. 

Auto Extended Single 
Patch Selection Paste 

On If selected, a single patch can be selected for pasting multiple 
patches from the clipboard. All legal patches are used to fill up 
the remainder of the bank starting from the selected patch 
(taking into account the other settings, such as not overwriting 
filled patches). 

Overwrite Filled 
Programs 

Off If selected, already filled programs can be overwritten by pasted 
programs. 

Overwrite Filled 
Combis 

Off If selected, already filled combis can be overwritten by pasted 
combis. 
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Overwrite Filled Set 
List Slots 

Off If selected, already filled set list slots can be overwritten by 
pasted set list slots. 

Table 20: Copy/Paste Settings 

Note that when incomplete combis and set list slots is selected, and these are pasted to another PCG 

file, it may result in broken combis and set list slots (depending on what is currently loaded in the 

workstation before loading the PCG file). 

When the setting Paste Duplicate Programs, Combis or Set List Slots is deselected, and patches are 

pasted to the same or another PCG file, if those patches already exist in the PCG file to be pasted to, 

these programs, combis and set list slots will be automatically removed from the clipboard without 

being pasted.  

When pasting in the same PCG file and combis have been copied, the used programs will 

automatically be removed because it simplifies copy/pasting patches.  

Also, when set list slots are pasted in the same PCG, the programs and combis (including used 

programs) are automatically removed because it simplifies copying set list slots. 

The reason duplicate Set list slots are allowed to be pasted by default, is that set list slots are used 

multiple times with the same references and parameters (volume, description etc). 

Duplicate patches are considered patches that are 100% equal, but the name is ignored for the 

equality check. 

[WARNING]: When one or more of the settings for overwriting patches is selected, it is possible to 

paste multiple times over the same patch, resulting in overwriting earlier pasted patches and in 

broken combis and/or set list slots. 

Take a look at the settings BEFORE starting a copy/paste action, because after the first paste, some 

options are not allowed to be changed once a copy/paste action is active (i.e. one or more patches 

have been pasted in a PCG file and the clipboard is not empty thus the current copy/paste action is 

unfinished). These are: 

 Paste Duplicate Programs 

 Paste Duplicate Combis 

 Paste Duplicate Set List Slots 

The (Cut)/Copy/Paste settings are retained and do not have to be set again after each restart of the 

application and are saved immediately after pressing the OK button (which also closes the settings 

dialog). 

7.3.7.6.3 Restore Button 

The restore button can be used to restore the settings of the (Cut)/Copy/Paste settings back to the 

default, shown in Table 20. 

The following ways can be used to select this command: 

 Click the Restore button. 

 Press Alt-r until the Restore button is highlighted and press Enter. 
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7.3.7.7 Cut/Copy/Paste Exit Command 

This command ends the active copy/paste operation and clears the clip board. 

The following ways can be used to select this command: 

 Select the Cut/Copy/Paste Exit menu item in the Edit menu. 

 Select the Cut/Copy/Paste Exit tool bar icon in the toolbar (page with a cross in the top left 

corner). 

 Press Alt-e until the Exit button is highlighted and press Enter. 

 Click the Exit button. 

This command should be used when you accidentally pasted something (in the wrong file or wrong 

location) and wants to end the active copy/paste operation. Note that an undo is not possible, so the 

(unintended) pasted patches can/should be removed manually if needed. 

Because this command should be used with care the dialog shown in Figure 37 warns you about the 

consequences. 

 

Figure 37: Copy/Paste Exit Warning Dialog 

[WARNING]: This command should be performed with care, because when exiting copy/paste mode, 

not all patches are already pasted and combis and set list slots may contain references to unpasted 

patches, resulting in broken combis and set list slots. When exiting cut/paste mode, patches have 

been cleared but not yet pasted again. 

7.3.7.8 Cut/Copy/Paste Recall Command 

This command can be used to recall the original copied patches again to repaste them again. 

The following ways can be used to select this command: 

 Select the Recall menu item in the Edit menu. 

 Select the Cut/Copy/Paste Recall tool bar icon in the toolbar (page with a blue R in the top 

left corner). 

 Press Alt-r until the Recall button is highlighted and press Enter. 

 Click the Recall button. 
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This command can be used after a cut/paste or copy/paste action to perform the paste operation 

again without selecting the originally copied patches again. It automatically selects the used 

programs for copied combis and used programs/combis and programs in used combis for copied set 

list slots. 

[TIP]: Suppose you have a program you like to copy 20 times. Follow the instructions to perform this: 

 Copy the program. 

 Paste it to the requested location (inside the same PCG file or another). Then the clipboard 

will be empty again.  

 Press the Recall button. The copied patch will be in the clip board again for another paste 

action.  

 Paste it again.  

 (Optionally: then select both programs and copy them so you have two (equal) programs 

copied in the clip board) 

 Press Recall again and continue pasting and you have 20 equal programs (using a new 

copy/paste to select even more programs at the same time). 

7.3.7.9 Cut/Copy/Paste Examples 

7.3.7.9.1 Introduction 

Since cut/paste and copy/paste operations are not trivial as can be read in the previous paragraphs, 

the following paragraphs are dedicated for examples and usages of the Copy/Paste possibilities 

within PCG Tools. 

The following examples are handled: 

 Copying programs inside a PCG file. 

 Copying programs from one PCG file to another PCG file. 

 Copying combis inside a PCG file. 

 Creating a PCG file with default set list slots [KRONOS ONLY]. 

 Using cut and paste (inside a PCG file). 

 Having fun with Copy and Paste. 

Note that depending on the cut/copy/paste settings (see Paragraph 7.3.7.5.1), a lot more options 

and use cases are available, but I leave these to try yourself. Some settings will be handled though. 
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7.3.7.9.2 Example: Copying programs inside a PCG file 

This example shows how to copy multiple programs inside the same PCG file. 

Perform the following steps: 

1. Select the Copy/Paste settings. 

2. Open a PCG file. 

3. Check Paste Duplicate Programs and press OK.  

4. Select a few programs from a program bank. 

5. Copy these to the clipboard. The clipboard will show the copied programs. 

6. Go to another part of the program bank or another bank (of the correct type if applicable) 

and find some empty spaces, select the first of them. 

7. Select the Paste command. Combis and set list slots will NOT reference to the newly pasted 

programs, so you only copy the programs without changing combis/set list slots. 

8. The programs will be pasted and the clipboard will be empty. 

The result of copy/pasting programs U-G014 until U-G16 to the programs starting at U-G019 can be 

seen in Figure 38. 

 

Figure 38: Copy Programs inside a PCG file 
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7.3.7.9.3 Example: Copying programs from one PCG file to another PCG file  

This example shows how to copy multiple programs from one PCG file to another PCG file. 

Perform the following steps: 

1. Open two PCG files (e.g. a source PCG file called Kronos.pcg and a destination PCG file called 

KronosNew.pcg) from the same workstation model. 

2. Select a few programs from a program bank from the source PCG file. 

3. Copy these to the clipboard. The clipboard will show the copied programs. 

4. Go to the destination PCG file and find some empty spaces, select the first of them. 

5. Select the Paste command. Combis and set list slots will NOT reference to the newly pasted 

programs. 

6. If you get a big warning dialog, then probably the programs you tried to paste are already 

existing in the destination PCG file and by default pasting duplicating programs is disabled. 

Change the copy/paste and continue with step 2. 

If successful, the programs will be pasted to the destination PCG file and the clipboard will be 

empty. 

The result can be seen in Figure 39. 

 

Figure 39: Copy Programs from one PCG file to another PCG file 
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7.3.7.9.4 Example: Copying combis inside a PCG file 

This example shows how to copy combis inside a PCG file. 

Perform the following steps: 

1. Select the Copy/Paste settings. 

2. Open a PCG file. 

3. Check Paste Duplicate Combis and press OK.  

4. Select approximately five combis from a combi bank. 

5. Copy these to the clipboard. The clipboard will show the copied banks and also the programs 

(possibly split in sampled programs and modeled programs). 

From here you can first copy the programs, and then the combis or vice versa. However, when the 

default Copy/Paste settings (except for the changed Paste Duplicate Combi setting changed above) 

are used, programs will not be pasted, but let us try to do anyway: 

6. Go to a program bank and find some empty spaces, select the first of them. 

7. Select the Paste command. You probably get a warning box that no patches have been copied. 

This is normal, because the copy/paste setting for pasting duplicated programs is switched off. 

Since all used programs are already present in the PCG file they are not pasted. Also note that all 

programs (not only from the type of programs which can be stored in the program bank) are 

removed from the clipboard. 

Now we have seen the programs cannot be pasted. (You can paste them if you want to, but to do 

that, the copy/paste setting for pasting duplicate programs should be checked).  

Now we paste the combis: 

8. Go to a combi bank and find some empty spaces, select the first of them. 

9. Select the Paste command. The pasted combis show up and the clipboard is empty. 

As usual, when pasting programs and combis (in which order does not matter), all references of 

combis to programs and set list slots to programs and combis will be fixed so that combis and set list 

refer to the correct programs and combis. 

7.3.7.9.5 Example: Creating a PCG with default set list slots [KRONOS ONLY] 

This example shows how to create a PCG file that only contains the programs, combis and used 

programs from combis used in the default set list slot. 

Perform the following steps: 

1. Open a PCG file (in this example assumed to have name Kronos.pcg). 

2. Save this PCG file as SetListOnly.pcg. 

3. Clear all program banks by selecting Programs, select all banks on the left side and press the 

Clear button. 

4. Do the same with all combi banks. 

5. And also with all set lists. 

6. Open the original PCG file again (Kronos.pcg) 

7. Select from SetListSlotOnly.pcg the first set list (on the left side). 
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8. Press Copy. You see that 57 sampled programs, 128 modeled programs, 9 combis and 127 set list 

slots are copied. 

9. Select a combi bank and press Paste. Note see that all combis are pasted in this bank. 

10. Select a modeled program bank and press Paste. Note that all modeled programs are pasted in 

this bank. If there is not enough space, some modeled programs would stay in the clip board. 

11. Select a sampled program bank and press Paste. Note that all sampled programs are pasted in 

this bank. 

12. Now paste all set list slots. 

13. Now everything is pasted, the copy/paste mode is inactive again (note that the Exit button is 

disabled). 

14. Save the PCG file. 

[TIP]: You can use these steps to create a small PCG file which only contains programs/combis of the 

set lists you use. When you want to remove the unused banks, load it in the Kronos and save the PCG 

file again with only the (partially) filled banks. 

7.3.7.9.6 Using cut and paste (inside a PCG file) 

This example shows how to use cut and paste. Both some programs, combis and set list slots will be 

pasted. 

Perform the following steps: 

1. Open a PCG file. 

2. Select three programs and press Cut. Notice that the Clipboard contains the cut programs and 

the selected programs are cleared.  

3. Now find an empty bank of the same type (sampled or modeled) and select one program. Press 

Paste and notice all programs are pasted, clearing the Clipboard. 

4. Now try steps 2 and 3 again but cut as above 3 programs, but select two programs to paste to. 

Notice that two programs are pasted and one stays in the Clipboard. This last programs should 

also be pasted (can be in a different location). 

5. Try steps 2 and 3 again but select a complete program bank. You can paste to a program bank 

but also can select ranges (consecutive or not) of programs. 

6. Try steps 2 and 3 again with a few combis. Notice that unlike copy/paste operations, the used 

programs are not cut or copied to the Clipboard. 

7. Try steps 2 and 3 again with some set list slots. Notice that unlike copy/paste operations, the 

used programs and combis (and programs used in those combis) are not cut or copied to the 

Clipboard. 

7.3.7.9.7 Example: Having fun with Copy and Paste 

This example shows an advanced example what you can do with copy and paste. 

Perform the following steps: 

1. Open two PCG files (in this example assumed to be named From.pcg and To.pcg). 

2. Open the Copy/Paste settings and activate all Paste Duplicate check boxes and press OK. This 

makes is possible to copy all patches even though they may already exist in To.pcg. 

3. In From.pcg, select three combi banks which are completely or reasonable filled. 
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4. Copy them to the clipboard, resulting in (probably) a number of combis, and a number of 

samples and/or modeled programs in the clipboard.  

5. In my case I the clipboard consists of 525 Sampled programs, 277 Modeled programs and 512 (4 

banks) Combis. The 525 + 277 programs are the programs used by the combis. 

6. Go to To.pcg and select an empty combi bank. Press Paste and note that 128 combis are 

removed from the clipboard. The empty combi bank is filled with 128 programs of the correct 

type that can be pasted (either sampled or modeled programs). 

7. Go to another combi bank and now select a range of (empty) combis with gaps, e.g. I-G000 to I-

G010 and I-G012 to I-G014 (use the shift and control keys to select/deselect patches).  

8. Press Paste and watch the selected combis being filled with patches from the clipboard. No 

programs are pasted yet. 

9. Let us now start to paste some programs. 

10. Select 2 empty or partially empty program banks (in my case one modeled and sampled program 

banks). Press Paste and see that filled programs are not being overwritten (this is a Copy/Paste 

setting) and that all empty programs in the program banks are filled with the correct type of 

programs (i.e. sampled programs in Sampled Program banks and modeled programs in Modeled 

Program banks). In my case I have 397 Sampled programs, 165 Modeled programs and 371 

Combis left to be pasted. 

11. I leave the rest of the pasting up to you. If you are tired or pasting everything, you can try Exit, 

but remember that only pasted patches are being connected (meaning combis that refer to 

programs that have not been pasted yet, will be broken). 
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7.4 Combi Window 

7.4.1 Content 

The Combi(nation) Window shows information about the timbres inside the selected combi and the 

most important parameters. 

Activation prerequisite: select exactly one combi. 

The command can be activated by: 

 Select the Timbres menu item in the Show menu. 

 Click the Timbres… button. 

 Press Alt-t until the Timbres… button is highlighted and press Enter. 

The Combi Window shows details about the selected combi as can be seen in the figure below. 

 

Figure 40: Combi Window 

The combi window shows the following information for each timbre (8 or 16 depending on the 

workstation model): 

 # : The number of the timbre, ranging from 1 to 16. 
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 Prg ID : The program ID of the program where the timbre is referencing to1. 

 Program Name : Name of that program2. 

 Category : Category of that program2. 

 Sub Category : Sub category of that program3,2. 

 Vol : Volume of that program. 

 Sta : Status of that program. 

 Mute : Mute on/off of that program (depends on work station model) 

 Pri : Priority of that program (depends on workstation model). 

 MIDI : MIDI Channel of the timbre. 

 Key Zone : Key zone where that program is assigned to, both lower and upper key. 

 Vel. Zone : Velocity zone where that program is active, both lower and upper velocity. 

 OSC Mode : Oscillator mode of that program. 

 OSC Sel : Oscillator select of that program. 

 Trans : Transpose of that program. 

 Porta : Portamento (time or according program) of that program. 

 BRng : (Pitch) Bend Range of that program. 

The Assigned Clear Program is used for clearing timbres and will be discussed in paragraph 

7.4.2.3. 

7.4.2 Commands 

7.4.2.1 Move Up Command 

Activation prerequisite: select one or more timbres in the patches list, without selecting the first 

patch.  

The command can be activated by: 

 Select the Move Up menu item in the Edit menu. 

 Click the Up button. 

 Press the up cursor key on the numeric keyboard (on the 8 key). 

 Press Alt-u until the Up button is highlighted and press Enter. 

This command moves all selected timbres one position up. The selected timbres do not have to be 

contiguous.  

When this command is used, the changed file attribute (the asterisk in the title of the window) will 

not be shown in the Combi window, but in its parent PCG file window. 

7.4.2.2 Move Down Command 

Activation prerequisite: select one or more timbres in the timbres list, without selecting the last 

patch.  

The command can be activated by: 

                                                           
1
 In case of a General MIDI program, always GM is shown as bank, even if the bank is g(1)..g(d). 

2
 In case of a General MIDI program, ??? is shown since that information is not available.  

3
 Workstation model dependent feature. 
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 Select the Move Down menu item in the Edit menu. 

 Click the Down button. 

 Press the Down cursor key on the numeric keyboard (on the 2 key). 

 Press Alt-d until the Down button is highlighted and press Enter. 

This command moves all selected patches one position up. The selected patches do not have to be 

contiguous.  

When this command is used, the changed file attribute (the asterisk in the title of the window) will 

not be shown in the Combi window, but in its parent PCG file window. 

7.4.2.3 Clear Command 

Activation prerequisite: select one or more timbres. 

The command can be activated by: 

 Select the Clear menu item in the Edit menu. 

 Click the Clear button. 

 Press Alt-c until the Clear button is highlighted and press Enter. 

This command clears the selected timbre(s). Clearing a timbre means: 

 Program set to the Assigned Clear Program shown in the bottom of the screen.  

 Status set to Off. 

 Muted. 

 Volume set to 0. 

 MIDI Channel set to 16. 

 Bottom/Top key set to the lowest key. 

 Bottom/Top velocity set to 0. 

 Osc Mode set to Mono. 

 Osc Select set to OSC2. 

 Transpose set to 0. 

 Portamento set to 0. 

 Bend Range set to 0. 

When this command is used, the changed file attribute (the asterisk in the title of the window) will 

not be shown in the Combi window, but in its parent PCG file window. 

The reason that some values may seem strange (e.g. like setting the bottom/top velocity both to 0), 

is on purpose. This way, it is immediately visible on the workstation that this timbre is not used. 

When copy a timbre from another combi on a workstation, automatically all parameters will be 

overwritten anyway. For the Kronos however there is even a better solution; see the next paragraph. 

7.4.2.4 Assigned Clear Program 

A combi can contain up to 8 or 16 timbres, depending on the workstation model. However, in most 

cases not all of these are used. It is very hard to see which timbres are used and which not, except on 

the page that shows the State (INT/EXT/EX2) or Mute (On/Off). Therefore, when clearing timbres 
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some values on other pages will have non default values to see more easily that timbres are not 

used. 

For the program being used for a cleared program, the Assigned Clear Program is used which is 

shown in the bottom part of the Combi Window. This program can be changed in the following way: 

- Go to the PCG Window 

- Select a single program. 

- From the Settings menu, select the 'Assign Clear Program' menu option.  

Every opened Combi  Window will then display that Assigned Clear Program and use it. 

The program has to be set once per PCG Window that is opened. The reason is that every PCG file 

can have different programs so it is not possible (easily) to store this value. Once set, it will be used 

for all Combi Windows opened within that PCG file. 

TIP: For the Kronos (X) this function is even more useful. When using a program that uses a sample 

that is not loaded, a red bar in the top of each screen of that Combi will show up. So you can see 

immediately in all Combi screens that that particular timbre is not used. Therefore, it is advised to 

create a program with an unloaded sample in it and use that program as the Assigned Clear Program. 

7.5 Generate List 
With this command you can make different kind of lists based on the information in the PCG.  

The command can be activated by: 

 Select the Generate List menu item in the Tools menu. 

 Press Ctrl-G key. 

 Select the Generate List tool bar icon in the toolbar (the page with the grey thick lines on it). 

 Click the Generate List… button. 

 Press Alt-g 

A new dialog is shown with a lot of options. The most important is the List Type group box, where 

you can select what kind of list type you want to generate (and if applicable list sub type). With other 

settings you can change filtering, sorting and selecting the output. 

After selecting all options, press the Generate button to show the output. 

7.5.1 List Types 

The types of lists that can be generated is shown in Table 21.  

List Type Description 

Patch List Generates a list that contain programs, combis and set list slots. 

Program Usage List Generates a list that per program shows in which combis it is used. 
It also shows per program and combi in which set list slots those are used. 

Combi Content List Generates a list of timbres per combi. 

Differences List Generates a list of patches that are (more or less) duplicates. 
Table 21: List Types 
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All options will be explained in Paragraph 7.5.2). 

In the following paragraphs each list type is explained in detail. 

For each list type some output formats are shown except for CSV files (since these require some post 

processing, see Paragraph 7.5.2.7.1). 

7.5.1.1 Patch List 

The patch list shows a list of all (filtered) programs, combis and set list slots. 

The table below shows all columns being generated. 

Column name Description Conditions 

Patch Name Name of the program, combi, or set list 
slot 

- 

Patch Type Program, Combi or Set List Slot - 

Patch ID ID of the patch, e.g. I-B036 for programs 
or combis or 001/017 for set list slots. 

- 

Category* Category name or number of the 
program or combi 

Only displayed for programs or combis. 

Sub Category* Sub category name or number of the 
program or combi 

Only displayed for programs or combis 
and if supported by the workstation 
model. 

Set List Slot 
Description* 

Description of the set list slot. Only displayed for set list slots. 

* For the ASCII Table output format, when the work station model supports Set List Slots, these three 

columns share a column named "Category/Sub Category for Programs/Combis or Set List Slot 

description for Set List Slots". 

Below are some examples of fragments of generated Patch Lists. 

 

Figure 41: Patch List in ASCII Table, sorted by name 
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Figure 42: Patch List of programs only, in ASCII Table output, sorted by bank/index. 

 

Figure 43: Patch List with Combis, Text Output 

 

Figure 44: Patch List with Set List Slots, XML Output (shown in browser) 
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7.5.1.2 Program Usage List 

The Program Usage List shows a list that contains for each program, all combis and set list slots 

where that program is used in. 

The Filter Program Banks options can be used to only check those programs. 

For all programs (selected in the Filter Program Banks), the settings in the Combi Banks and Filter Set 

Lists groups are used for each program. 

[EXAMPLE]: If only the I-A and I-B banks in Filter Program Banks are selected and U-C and U-D combi 

banks and set list 1 to 5, then a list will be generated that checks for all programs in banks I-A and I-B 

if they are used in combi banks U-C and U-D and/or set lists 1 to 5. 

The following figures show some examples of fragments of the output. 

 

Figure 45: Programs Usage List, ASCII Table Output 

This means: Program I-A000 is used in combi I-A019, I-A048, I-A065 etc. and used in set list 0, slot 0, 

set list 1, slots 6, 17 and 30. 

 

Figure 46: Programs Usage List, Text Output 
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Figure 47: Programs Usage List, XML Output 

7.5.1.3 Combi Content List 

The Combi Content list shows a list of all (filtered) combis with some generic info about those 

timbres and information about the timbres. This list type has three list sub types, which configures 

the amount of detail to be shown. 

7.5.1.3.1 Compact Combi Content List 

This list shows the programs used by each timbre after removing duplicates and ordered by 

bank/index. 

 

Figure 48: Combi Content List, Compact form, ASCII Table Output 

7.5.1.3.2 Short Combi Content List 

This list shows the programs used by each timbre in the correct timbre index. 

 

Figure 49: Combi Content List, Short Form, ASCII Table Output 
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7.5.1.3.3 Long Combi Content List 

This list shows more detailed info about each (filtered) combi and its used programs. 

Depending on the number of combis selected, the output can be very long (max. 26 lines per combi, 

on a Korg Kronos this would result for all combis a text file of almost 30,000 lines, the default is 

10,000 lines). However, even if the output can be a long file, the generation is finished almost 

instantly. 

Because the output is not a table and text output would not look nice, only ASCII Table output is 

selectable for this list sub type. 

 

Figure 50: Combi Content List, Long Form, ASCII Table Output 
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7.5.1.4 Differences List 

This list differs each (filtered) patch to all other patches (of the same type) and list them if they are 

(more or less) equal. For this type of list, some extra options are available in the Differences List 

Options which are only enabled if the Differences list is selected and these options are shown below.  

Item Name Description 

Max Number of Differences (in 
bytes) 

Defines how many bytes a patch may differ at maximum. A rough 
thumb rule is that one parameter equals one byte. 

Ignore Patch Names Since a patch name is irrelevant for the sound/settings of the 
patch, when unchecked, the patch name will not be taken into 
account for calculating the number of differences between two 
patches. 

Ignore Set List Descriptions Since a set list slot description is irrelevant for the sound/settings 
of a set list slot, when unchecked, the set list description will not 
be taken into account for calculating the number of differences 
between two set list slots. 

Search Both Directions Normally, each patch only checks patches further into the 
banks/indices, which this option you can switch this search 
algorithm off. 
E.g. When unchecked, program I-C040 is checked against 
programs I-C041 to I-C127 and all patches in further banks 
(assuming the Filter Program Banks has all bans selected). 

Table 22: Differences List Options 

To generate such a list can take a lot of time, especially for the Kronos (which has a lot of program 

banks), if all program banks are selected (default setting). With the default settings, creating a 

difference list for a complete Kronos PCG file takes (on my computer) about 25 seconds. If you 

change the max. number of difference to 500 (bytes), it takes 2 minutes, 20 seconds. 

For an Oasys default PCG file generating this list costs about 20 seconds and for other workstations 

(considerably) less. 

[WARNING]: For PCG files created with a Kronos with OS1.5, certain parameters (such as 

program/combi references are not always taken into account). This can result in a few too less 

differences being counted. 
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Table 23 shows the properties/settings affecting the speed of generating this list. 

Item Name Description 

Max Number of Differences (in 
bytes) 

The more differences are allowed, the longer it takes to check 
two patches against each other (if more than the maximum 
number of specified changes have been found, the check is 
stopped, and the next set of two patches can be checked). 

Search Both Directions Note that searching in both direction can take twice as long, 
because all previous patches have to be calculated for the 
number of differences too. 

All filter settings Since the filter settings which patches to be checked, it 
immediately affects the number of pairs to be checked. Especially 
the amount of program banks selected (either by Filter on Text, 
Filter Program Banks and Filter on Favorites) matters. 

Speed of the (available) 
computer CPU/Cores 

The processing speed of your computer also affect the speed of 
generating this list. 

Table 23: Properties/Settings affecting generation speed of Differences List 

[BACKGROUND]: Suppose all program banks are selected (20 on a Kronos, GM banks are ignored). 

Then 20 * 128 = 2560 patches have to be checked against each other, resulting in 6.5M pairs of 

programs to be checked (if Search Both Directions would be enabled, otherwise it can be halved). Let 

us assume almost all programs are quite similar and all programs are EXI (modeled) programs using 

4960 bytes. This means 6,5M x 4960 bytes = 3.25x1010 byte difference checks.  

For non Kronos PCG files it probably takes not that long, but since the computer CPU also is relevant, 

always the following warning is displayed: 

 

Figure 51: Dialog before generating a Differences List 
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7.5.2 Settings 

Besides the list types mentioned already before, a lot of settings can be made to tweak the list 

generation. Most have to do with filtering (decreasing the number of items in the list), sorting and 

selecting the output type. In the following paragraphs all settings will be explained in more detail. 

7.5.2.1 Filter On Text 

The settings in this box are used for using only patches with a certain (part of the) name. In Table 24 

is shown what each setting means. 

Setting Description 

Filter On Text With this option you can switch on/off text searching. If switched on all 
other controls become enabled. 

Filter On Text, Text part Text to be used for filtering. Below can be defined what parameters are 
used for text filtering. 

Case Sensitive If switched on, the text entered has to be exactly be a part of the patch 
name/description, otherwise the case is irrelevant. 

Filter Program Names When switched on, all programs containing a part of the filter text in their 
name are used. If switched off, program names are not filtered for text. 

Filter Combi Names When switched on, all combis containing a part of the filter text in their 
name are used. If switched off, combi names are not filtered for text. 

Filter Set List Slot 
Names 

When switched on, all set list slots containing a part of the filter text in 
their name are used. If switched off, set list slot names are not filtered for 
text. 

Filter Set List Slot 
Descriptions 

When switched on, all set list slots containing a part of the filter text in 
their descriptions are used. If switched off, set list slot descriptions are 
not filtered for text. 

Table 24: Filter On Text Settings 

[Example]: To find out all patches (programs, combis and set list slots) that have piano in their name, 

switch on Filter On Text, type as text 'piano', switch off case sensitive, enable all other filtering 

settings and press Generate. Figure 52 shows a fragment of the output.  

Note that if you would have searched the category for keyboards/pianos on your workstation, you 

would not have found Combi I-A019 since it is in category BassSplits. 

 

Figure 52: Searching for patches with a certain name in it (1) 
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[Example]: You cannot remember where the patch (program or combi) is located with the name 

Indigo in it. Just search for it and get something like Figure 53.  

 

Figure 53: Searching for patches with a certain name in it (2) 

[EXAMPLE]: When adding a special text to any of the patch names you want to mark in a special way, 

you can generate a patch list containing this mark. E.g. when marking a program with ^ at the end to 

show you have edited it or have created it yourself, you can very easily create a patch list with a filter 

on this character to get a list of all patches you edited/created. 

[TIP]: [NON KRONOS ONLY]: You can use the example above to emulate favorite programs by using 

e.g. %F or one or two other symbols. Of course you will not be able to search it directly on your 

workstation but by creating a list with PCG Tools it is easy to find them. 

[EXAMPLE] [KRONOS ONLY]: When you put in the description of your set lists keywords you can find 

them very easily. For example, if you put the text #SET1 in your description for every song that you 

play in set 1 of your band and #SET2 and #SET3 for your other sets, you can very easily make set lists 

by generating a patch list containing all set lists containing the word SET (for all 3 sets), SET1, SET2 or 

SET3.  You even can use multiple keywords for the same set list slot, e.g. adding keywords #SET1, 

#SELFMADE, #PROJECT_X. 

If you use this option, also consider using PCG Tools for editing set list slots, because it can add 

returns (new lines), so you can put your keywords on new lines in such a way you will not see them 

directly when iterating through the set list slots. 

7.5.2.2 Filter Program Banks 

This box contains a lot of settings, but the most important are all program bank check boxes. It only 

shows program banks that are valid for your workstation (although some Korg Triton Workstation 

might show too many).   

Program banks which are not present in the PCG file cannot be selected (these are disabled). Also the 

GM bank is default switched off (it is not in the PCG file).  

The buttons Select All and Deselect All can be used for switching all program banks present in the 

PCG file on or off. Note that the GM bank is also switched with this setting so check it manually 

before using it to generate a list. 

Furthermore it has two different options: 

 Ignore Empty/Init Programs: Default it is switched on, to make sure empty or init programs 

will not be used for generating lists. This means that programs with an empty name (after 

clearing them) or with an initialized name (default name after initializing a program on your 
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workstation) will not show up in the Patch List, or will not be used in the Program Usage List 

or any other list. 

 Ignore First Program: In most cases, unused timbres reference to program I-A000 or A000 

even if not used. These unused timbres are mostly muted or have a status set to OFF, but 

sometimes you might want to show every reference, but there are cases of PCG files where 

this is not true, so this setting can be changed to be flexible.  

7.5.2.3 Filter Combi Banks 

Filter Combi Banks acts like Filter Program Banks (see previous paragraph), but for combi banks.  

This box contains a lot of settings, but the most important are the combi bank check boxes. It only 

shows combi banks that are valid for your workstation (although some Korg Triton Workstation 

might show too many).   

Combi banks which are not present in the PCG file cannot be selected.  

The buttons Select All and Deselect All can be used for switching all combi banks present in the PCG 

file on or off. 

Furthermore it has two different options: 

 Ignore Empty/Init Combis: Default it is switched on, to make sure empty or init combis will 

not be used for generating lists. This means that combis with an empty name (after clearing 

them) or with an initialized name (default name after initializing a combi on your 

workstation) will not show up in the Patch list, or will not be used in the Combi Usage List or 

any other list. 

 Ignore Muted/Off Timbres: This option is only used for the Combi Content List (which shows 

timbre information) and Programs Usage List (which uses references to programs from 

combis). Normally you do not want to have muted or programs with status Off being used in 

lists, however some users switch timbres on while playing (especially live) and then those 

programs should be used while generating a list. 

[Example]: To show for all programs in program bank I-C in which of combi I-A to I-G they are used, 

select Program Usage List, select the program and combi banks mentioned above and generate the 

list. Figure 54 shows a fragment of the output. 

 

Figure 54: Combis using a Program 



Chapter 7 - PCG Files  Paragraph 7.5 - PCG Window / Generate List 
 

 
80 

 

[Example]: To show for all combis from combi banks I-A to I-G the usage of programs in program 

bank I-C, select Combi Content List, select the program and combi banks mentioned and generate 

the list. Figure 55 shows a fragment of the output. You also can use a Long sub type, to get more 

details from the timbres. 

 

Figure 55: Programs being used by Combis 

7.5.2.4 Filter Set List Slots [KRONOS ONLY] 

This setting is used to filter for set lists. The Enabled button switches the complete filtering for set 

lists on or off and the range (both inclusive) specifies which set lists to be taken into account.  

The button Select All is used to select all set lists which are filled (partially or complete).  

[EXAMPLE]: To get a list of which programs are used by set list slots of set list 0 (default), select 

Program Usage List, deselect all combis, set the filter set lists range from 0 to 0 and press Generate. 

Figure 56 shows a fragment of the output. 

 

Figure 56: Programs used by a certain Set List Slot 
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7.5.2.5 Filter on Favorites [KRONOS ONLY] 

(   [NON KRONOS ONLY]: See one of the examples in paragraph 7.5.2.1.    ) 

This setting filters the lists by using only patches marked as favorite. 

For the Programs Usage List and the Combi Content List only the main type is filtered for the favorite 

setting, meaning that for the Programs Usage List, only the programs' favorite settings are taken into 

account and not the combis' favorite settings. 

For the Combi Content List it means that only the combis' favorite settings are taken into account 

and not the programs' favorite settings. 

The Favorites setting can have three states: 

 Indeterminate (filled box): Both favorite and non favorite patches are taken into account. 

 Checked (√ symbol) :  Only favorite patches are taken into account. 

 Unchecked (empty box):  Only non favorite patches are taken into account. 

Set lists are used independent of the setting of Filter on Favorites. 

7.5.2.6 Sorting 

Currently three sorting types are available, which are explained in the following paragraphs. 

The sorting method is only used for the Patch List, for other types it is not supported. 

[TIP]: If a certain sort method is not supported or available, you always can generate a comma 

separated value (CSV) file for certain list types and reorder it in the spreadsheet. 

7.5.2.6.1 Type/Bank/Index 

This is the default sorting method, which sorts in the following order: 

First order key is type, which is 1) Programs, 2) Combis, 3) Set List Slots 

Second order is bank, which is the program bank, combi banks and set lists. 

Third order is the index within the bank. 

This means the order of a complete PCG patch list is: 

1. Program Bank A, index 0 to 127 

2. All consecutive program banks 

3. Combi Bank A, index 0 to 127 

4. All consecutive combi banks 

5. Set List 0, slots 0 to 127 

6. All consecutive set list slots. 
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Below is an example of a fragment of the (default) Type/Bank/Index sorted Patch List. 

 

Figure 57: Type/Bank/Index Sorted Patch List 

7.5.2.6.2 Category, then Patch Name 

This is the sorting method, based on categories: 

 First order key is category. 

 Second order key is sub category (or ignored if the workstation model does not support it) 

 Third sort order is the patch name. 

If the PCG file does not contain the global section, then category (and sub category) names are not 

available. However, category numbers and sub category numbers are so it will not matter in reality. 

Since set list slots do not have categories (nor sub categories), set list slots will be appended at the 

end, sorted only by set list slot name. 

Below is an example of a fragment of a category sorted Patch List. 

 

Figure 58: Category Sorted Patch List 
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7.5.2.6.3 Patch Name 

This is the sorting method, based on patch names. 

Below is an example of a fragment of the patch name sorted Patch List. 

 

Figure 59: Patch Name Sorted Patch List 

7.5.2.7 Output 

There are several type of output formats that can be used for generating lists. 

The name of the file is shown in the output field. You can type in the file name to be used as output 

file or browse for a file to be overwritten.  

You can use a default extension but it is not necessary. In case you use do not use a default extension 

(like .txt for a CSV file), then the application connected to such a file is not automatically opened. 

In the following paragraphs each output type will be explained in detail with examples. 

7.5.2.7.1 ASCII Table Output 

This is the default output type showing a text file using ASCII characters (+, - and |, see below) for 

creating a table which is opened by your default text viewer/editor as long as the output file ends 

with .txt; the default name is output.txt. 

Below is an example of a fragment of a Patch List with ASCII Table output. 

 

Figure 60: ASCII Table Output 
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7.5.2.7.2 (Plain) Text Output 

This output format shows the same columns as the ASCII Table format except it does not generate 

the ASCII characters that creates the horizontal and vertical lines. 

Below is an example of a fragment of a Patch List with Text output. 

 

Figure 61: Text Output 

7.5.2.7.3 CSV (Comma Separated Value) File Output 

This output format creates a so called Comma Separated Value file, or in short CSV file. 

Depending on the setting of your computer, these files are automatically loaded by a spreadsheet 

application, for example Microsoft Excel©. In MS Excel it will show up as text lines separated with 

commas and should be manually converted to separated columns. To do this, perform the following 

steps (example for MS Excel 2011 but other versions have similar capabilities): 

1. Select the first column (A). 

2. In the Data ribbon control tab, select the icon 'Text to Columns'. A dialog is shown. 

3. Press the Next button. 

4. In the next screen (step 2 of 3) select 'Comma'.  

5. Press the Next button. 

6. In the next screen (step 3 of 3) press 'Finish'. 

7. Double click on each column transition to automatically change the width of each column or 

do it manually. 

8. Now you can use all possible spread sheet function to further process the data. 

 

[WARNING] Make sure you close the Excel file before generating a new CSV file with the same name. 

If not, the file that is open cannot be overwritten (generated) by PCG Tools and the following error 

will show up: 

 

Figure 62: Error message after document in use. 
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The output will look like Figure 63. 

 

Figure 63: CSV (Comma Separated Values) Output in Microsoft Excel 

In case there is no spread sheet application coupled to the .csv extension or you selected a .txt 

extension instead of a .csv extension, probably a text viewer/editor will be opened and an example 

fragment of the output will look like below. 

 

Figure 64: CSV (Comma Separated Values) Output as Text File 
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XML 

This output format creates a so called E(X)tensible Markup Language, or XML file. XML files are 

widely used by internet application but also can serve as a structured data file for input by other 

applications. 

Together with an XML file a so called E(X)tensible Stylesheet Language, or XSL file is created. This file 

contains HOW the XML file is shown. 

When XML output is selected, normally the default browser will be opened to show the output, using 

the XML file as data content input and the XSL file as visualization of the data. 

Below a fragment of the output for a patch list is shown. 

 

Figure 65: XML Output 

[TIP]: If you want to use/see the source XML file, you can open the created files with a text editor, or 

depending on the browser, see the source (mostly via a right mouse button click on the generated 

page in the browsers). The XSL file should be browsed and opened in a text editor (manually). 
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Below a fragment of the XML source of a patch list is shown. 

 

Figure 66: XML Source of a Patch List 

Below a fragment of the accompanied XSL source of the patch list is shown. 

 

Figure 67: XSL Source of a Patch List 
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7.6 Additional PCG File Features 
In this paragraph additional features are explained. Currently there is one such feature: to export a 

PCG file to a Cubase® instrument definition file. 

7.6.1 Generating a Cubase Instrument Definition File 

This command can be used to generate an instrument definition file for Cubase. 

The following way should be used to select this command: 

 Select the Cubase sub menu item from the 'Export for Sequencer' menu item in the File 

menu. 

Cubase is a sequencer application that can use patch list for easy navigating through the patches 

from within the application. For this functionality, Cubase uses instrument definition files.  

This file can be copy/pasted to the Cubase directory after manually adapting if needed (depending on 

the Cubase version). However, manual adaptation is outside the scope of PCG Tools. Please refer to 

your Cubase documentation for the content of an instrument definition file. 

A fragment of the output is shown in the figure below. 

 

Figure 68: Cubase Instrument Definition File 
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8 Using SNG (Song) Files 
This file type contains songs created by the sequencer of your workstation. One such SNG file can 

contain multiple songs. 

A song file contains a lot of information and only a very small portion is analyzed with PCG Tools, 

namely the songs contained in the files and the samples being used by those songs. 

A song file can be opened by the regular Open command (see Paragraph 6.3.1). When the dialog is 

opened, select in the right bottom corner the correct type: SNG Files (*.sng) and open the song you 

want to be shown.  

Multiple song files can be opened and even song files from different workstation models.  

The window contains two tabs, one for songs information and one for samples information. These 

tabs are explained in more detailed in the following paragraphs. 

The status bar shows the workstation model, the type of file (SNG), the number of songs in the 

loaded SNG file and the number of samples used in the loaded SNG file. 

8.1 Songs Tab 
This tab shows the indices and the names of the songs contained in the SNG file and this tab will be 

opened by default. Below is an example of this tab. 

 

Figure 69: Songs Tab 
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8.2 Samples Tab 
This tab shows the samples that are used by all songs in the SNG file. Per sample, the index, name 

and (Sample) file name is shown. See below for an example. 

 

Figure 70: Samples Tab
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9 Q & A and Trouble-Shooting 
In the table below questions and answers and trouble-shooting information is supplied. 

Question/Problem Answer/Solution 

SETUP  

The .zip file gives a warning 
about possibly harmful software. 

Depending on the security settings and zip file settings, zip files 
and exe files (or exe files within zip files) are treated like possibly 
harmful files and blocked or show a warning. Depending on the 
OS and used unzip application there a lot of different solutions, 
but the following could be checked first: 
- Use the unblock function of the default zip application 
- When using WinRar®, select Options menu, Safety tab, and 
disable the unpacking of certain file types. Possibly there is a 
related setting with WinZip®. 

Why does installation take so 
long the first time? 

This application uses an extensive Microsoft library, called 
Microsoft .NET Framework 4. Sometimes it is already installed on 
your computer, sometimes not. If not, it will be automatically 
installed. 

I get an installation error while 
downloading the .NET 
Framework. 

Probably the needed Microsoft .NET Framework 4 library is not 
installed. If not, It will be automatically installed (the first time) 
when you install the application. For this an internet connection 
is needed and authorization (administrator rights possibly) to 
install this library. 
When you still get an error you can download it manually from 
http://www.microsoft.com/download/en/details.aspx?id=17718. 
If you still get an error try uninstalling the library and reinstall it. 

I get an installation error that the 
path is incorrect. 

Install the application from the same folder as before in case of 
an update. If you still run into problems, remove the following 
folder: 
c:\users\username\Local Settings\Apps \2.0 
in case of Windows XP or 
c:\users\username\AppData\Local\Apps\2.0  
in case of Windows Vista or Windows 7 or 8 
For other Windows (or emulator in case of Apple 
Macintosh/Linux) a similar folder should be deleted. 

PERFORMANCE  

Loading many PCG files make my 
computer slow. 

Some workstation, like the Korg Kronos creates full PCG files of 
42 MB. When loading PCG files into PCG Tools some overhead 
will be added so depending on the available RAM memory in 
your system, the Windows OS might use disk swapping which 
can decrease the performance of PCG Tools dramatically. Close 
unneeded PCG files to release more memory. 

  
Table 25: Q&A and Trouble Shooting

http://www.microsoft.com/download/en/details.aspx?id=17718
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10 Keyboard Usage & Shortcut Keys 
By default, the Windows operating system has a lot of automatic keyboard shortcuts and special 

predefined usages for selections and commands. Besides that, PCG Tools has some additional 

keyboard shortcuts. 

Most shortcuts need a special key, like the Control (Ctrl) or Alt key together with another key. For 

this a special notation is used, like e.g. Ctrl g is used which means: press AND HOLD the Control key, 

press the g key and release the g key without releasing the control key before releasing the g key. 

10.1 Keyboard Command Selection 
When pressing the left Alt key, all file menus, menu options and most screen controls show an 

underlined character. When the left Alt key is pressed together with that underlined character that 

control is focused. Pressing the Enter key (or space key for buttons), will activate/change the selected 

control. 

If there are multiple controls with the same underlined character, PCG Tools focuses to the next 

control with the same underlined character, even if it is on another opened PCG file (so you can also 

use this feature for jumping quickly to another PCG window by keyboard). 

To execute the focused control, press the Enter key.  

10.2 Generic Commands Shortcut Keys 
Key Command 

Ctrl F4 
Closes the current selected window (and sub 
windows). 

Alt F4 Exits the application. 

Alt Tab 
Go to the next application or in some cases 
another PCG Window, like the List Generator or 
the output of the list generator. 

(Shift) Alt Tab Go the previous application. 

Left Alt Tab 
Focus on the menu (you can use the cursor keys 
to navigate to the correct menu item and press 
Enter to activate the focused menu item). 

Ctrl Tab Go to the next control. 

Shift Ctrl Tab Go to the previous control. 

Alt + Space Focus on the window menu. 
Table 26: Generic Commands Shortcut Keys 

This list is not complete. For a complete list, see http://support.microsoft.com/kb/301583.  

Not all commands are usable in PCG Tools, but most keys that are related to PCG Tools are. 

http://support.microsoft.com/kb/301583
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10.3 Main Menu Shortcut Keys 
The short cuts shown below are active only when the menu is active.  

Key Command 

F10 Go to/from the Main menu 
Ctrl O File Open 
Ctrl S File Save 
Ctrl Shift S File Save as 

Table 27: Main Menu Shortcut Keys 

10.4 Keyboard Shortcut Keys and Mouse handling 
In an opened PCG file two lists are displayed: the Banks (or set lists) list on the left side and the Patch 

list containing programs, combinations or set list slots from the bank or list selected in the Banks 

Listview on the right side.  

One of the lists has a thick gray line around it, which shows the active list. Commands below the lists 

are executed for the selected items in the active list view only. 

[EXAMPLE]: When the Banks Listview is active and five banks are selected, and Left Alt + c is pressed 

to clear them, all patches within those five selected banks will be cleared. If the Patches Listview 

(right list view) would be active, then only the selected patches in the patch list will be cleared. 

Some commands are available depending on the active list (Banks Listview or Patches Listview).  

You can use multiple selections on both lists by using the Shift or Control key together with other 

keys or with the mouse. The shift key can be used to select a continuous range, the control key can 

be used to deselect or select items in a list without affecting other selections. 
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The table below shows the short cut keys possible on either list. 

Key Command 

Cursor Up Move the cursor one item up. 

Cursor Down Move the cursor one item down. 
Page Up Move the cursor one page up. 
Page Down Move the cursor one page down. 
Home Move the cursor to the first item. 
Home Move the cursor to the first item. 
End Move the cursor to the last item. 

Shift 
Keep the Shift key pressed to select a consecutive range (can be 
used in conjunction with the Control key).* 

Control 
Keep the Control key pressed to select multiple items (can be 
used in conjunction with the Shift key).* 

Ctrl Numeric 8 (Up) Moves the selected patch one location up. 
Ctrl Numeric 2 (Down) Moves the selected patch one location down. 
Left Mouse Button Double Click Opens the Edit dialog for the selected patch. 
Control x Cuts the selected banks or patches (for pasting later) 

Control c Copies the selected banks or patches (for pasting later) 
Control v Pastes the selected banks or patches (only allowed type). 
* These keys cannot be used to select multiple items by using the keyboard only, but only by 

concurrently using the mouse.  

Table 28: Keyboard Shortcut Keys and Mouse Handling 

10.5 PCG Window Shortcut Keys 
The table below shows the short cuts which can be used inside a PCG Window. 

Key Command 

Ctrl C Copy the selected items to the clip board 
Ctrl P Pasts the selected items possible to paste in the selected items. 

Table 29: PCG Window Shortcut Keys 

10.6 SNG Window 
For the Song window,  there are no short cut keys available. 
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11 Installation of Core FTP LE 
 (reference in workflow) 

 (add to advertised/external apps) 

11.1 Introduction 
The Korg Kronos from OS version 2.0 and the Korg Kronos X can make use of an Ethernet connection 

for transferring files. This is the ideal way of using PCG Tools because you do not need to use an USB 

stick or memory card for transferring the PCG file(s) from your workstation to your computer and 

vice versa. 

Below are the steps needed to set up such communication. 

11.2 Setup the FTP connection on the Kronos site. 
First the Kronos needs to have some values being entered for making an FTP connection possible. 

Perform the following steps: 

 Press the 'Global' button on your Kronos (X). 

 Go to the Basic tab. 

 Go to the Network tab. 

 Press the Configure button. 

 Enter a host name. This name can be anything but is needed later in an FTP application as 

identification for the Korg Kronos (X). 

 Set the Address Method to DHCP. This means that the Korg Kronos (X) automatically creates 

a number that uniquely identifies the machine. 

 Press the 'OK' button. 

 Select a user name (this can be anything). 

 Select a password (this can be anything). Remember the password well for later usage. 

11.3 Install Core FTP LE 
Perform the following steps: 

 First browse to http://www.coreftp.com/download.html. Core FTP (LE) is a free software 

application for managing FTP connections. There are also other (free) applications for FTP 

but I just used this application as example. 

 Download the latest free version for your operating system (32 or 64 bit) and run it. 

 You will see the following screen: 

http://www.coreftp.com/download.html
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Figure 71: Core FTP Installation screen shot 1 

 Press the button 'I Agree'. 

 You will see the following screen: 

 

 

Figure 72: Core FTP Installation screen shot 2 

 Press the 'Next' button. 

 You will see the following screen: 
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Figure 73Core FTP Installation screen shot 3 

 Press the 'Next' button. 

 You will see the following screen after the installation has been completed successfully: 

 

Figure 74: Core FTP Installation screen shot 4 

 Press the 'Close' button. 

11.4 Set up the FTP connection 
 Make sure that both the computer and the Korg Kronos (X) are connected to the same 

router/switch. 

 Start up Core FTP LE.  

 You will see the Site manager window. If not, select it from the Sites menu, sub menu Site 

Manager. 
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Figure 75: FTP Site Manager 

 Press the 'New Site' button and fill in the items according to the table below. All other values 

can be left to default. 

Item Value Remarks 

Site Name e.g. Korg Kronos (X) You can use any name here. 

Host / IP/ URL The host name you entered on the Korg Kronos (X)  

Username The user name you entered on the Korg Kronos (X)  

Password The password you entered on the Korg Kronos (X)  
Table 30: New (FTP) Site 

 Press the 'Connect' button. 

 You will see a screen similar as below. 
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Figure 76: FTP Connection 

On the left site is a folder on your computer; you can change this to any location. On the right side 

the Korg Kronos (X) SSD contents are shown. With the left and right arrow button you can copy files 

from the computer to the Korg Kronos (X) or vice versa. In the example above you can see the left 

arrow in the red circle). The arrow will only be enabled if one or more files are selected. 

Always make a backup file before you are going to change a PCG file with PCG Tools. 

After copying one or more PCG files from the Korg Kronos (X) to your computer, you can use PCG 

Tools to load it. When finished with PCG Tools (or in between if you like), save the file and copy the 

file with FTP Core LE to the Korg Kronos (X) and load it. 

Note that sample files are hidden and will not be shown. 
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12 History 

Version   Date        Type     Description 

----------- ----------- -------- -------------------------------------------------------------------------------------- 

0.1.1.1     01-Jul-2011 Initial: Initial version. 

0.1.2.49    30-Jul-2011 Support: Support for any kind of Korg Kronos PCG files. 

                        Support: Support for any kind of Korg Oasys PCG files. 

                        Improv.: Check for unsupported PCG file. 

                        Improv.: In the list generation window, empty/init banks or setlists are disabled. 

                        Bug Fix: In the program usage list, muted timbres were taken into account. 

                        Bug Fix: In the file selection dialog, the 'All' files options did not work.  

0.1.3.53    08-Aug-2011 Feature: Combi Content List. 

                        Support: Support for Korg Triton Extreme PCG files. 

                        Improv:  Added option to ignore first program and ignore muted or off timbres. 

                        Improv:  Added option for enabling filtering text in programs, combis, set list slot names. 

                        Bug Fix: Problem fixed with partial Korg Kronos/Oasys files. 

0.1.4.54    10-Aug-2011 Support: Support for Korg M50 PCG files. 

                        Support: Support for Korg M3 PCG files. 

                        Improv:  Wait cursor while generating lists. 

                        Improv:  (Much) Faster Combi Content List generation. 

0.1.5.62    14-Aug-2011 Feature: All lists can be generated in XML format. 

                        Improv:  Output file can be set (and opened by connected application) 

                        Improv:  Screen layout changed. 

                        Bug fix: CSV File format improved (can handle commas in names of patches) 

                        Bug fix: If the PCG file cannot be read, the app does not crash but gives a message box. 

0.1.6.64    18-Aug-2001 Feature: Differences List. 

                        Improv:  Changed parameters in command line interface. 

0.2.0.75     3-Sep-2011 Feature: Show banks with programs, combis and set list slots on GUI. 

                        Feature: Ability to change names of Programs, Combis and Set List Slots. 

                        Feature: Ability to change descriptions of Set List Slots. 

                        Improv:  CHanged text "Kronos PCG File Name" to "PCG File Name. 

                        Bug Fix: Default settings/enabling of UI checkboxes for filtering on text. 

0.2.0.76     4-Sep-2011 Bug Fix: Crash fixed when importing Oasys PCG files and pressing generate lists. 

0.2.1.78     7-Sep-2011 Feature: Moving programs, combis, set list slots up and down with automatic reference updating. 

            10-Sep-2011 Support: Support for Korg Triton (Classic), Triton Rack, Triton Le, Triton Le88, Triton Studio, 

                                 Triton TR 61/76/88. 

                        Support: Support for Korg Karma. 

                        Bug Fix: Fixed reading of Korg Triton PCGs with MOSS programs. 

0.2.2.80    12-Sep-2011 Feature: Select multiple programs, combis, set list slots for moving up/down. 

                        Improv:  Added menu and moved buttons to menu. 

                        Improv:  Added About window. 

                        Improv:  Show set lists that have changed names or with non default set list slots (-> I-A000) 

                        Improv:  Changed warning text for Differences List. 

                        Bug Fix: Fixed exception in Differences list with 'To' option in set lists filtering. 

                        Bug Fix: Fixed Initial Programs radio button selected when only set lists contained in PCG.  

0.2.3.118   24-Sep-2011 Feature: Open multiple PCG files at the same time. 

                        Feature: Added Status bar showing the amount of programs, combis and set list slots and banks in the PCG. 

                        Feature: Added Status bar field showing the Korg model type of the loaded PCG. 

                        Feature: Added Revert to Saved menu option (undo changes). 

                        Improv:  Replaced Combo box for bank/set list selection by list view. 

                        Improv:  Moved Label with loaded PCG file name flag to the title bar. 

                        Improv:  Added dirty flag (meaning PCG file has changed) as * to the title bar. 

                        Improv:  Added warning when closing the app or close a changed PCG. 

                        Improv:  Added Move Up and Move Down to Actions menu. 

                        Improv:  Changed the default list generator sort order from alphabetical to type/bank/index. 

0.2.4.120    6-Oct-2011 Feature: Copy programs inside a PCG or to another PCG. 

                        Feature: Copy combis inside a PCG or to another PCG while copying the used programs together. 

                        Feature: Copy set list slots inside a PCG or to another PCG while copying the used programs and combis together. 

                        Improv:  Commands in windows depend on selection of bank/patch selection list view. 

                        Improv:  Added column in banks for content type (Program bank shows Sampled/Modeled programs). 

                        Improv:  Added column in patches for Description (showing set list slot descriptions). 

                        Improv:  Double clicking a single patch shows the Edit window. 

                        Improv:  The short cut for the edit button is Alt-E (and had to remove the Edit menu short cut). 

                        Improv:  All banks/set lists are shown, also empty ones (useful for copy/paste functionality). 

                        Bug Fix: Prevented some crashes related to the menu. 

                        Bug Fix: Removed maximizing a PCG window when double clicking on the title bar. 

                        Bug Fix: Prevented crash when loading a PCG without program, combi and set list slot data. 

                        Bug Fix: Prevented crash when closing changed file after message box. 

                        Bug Fix: Owner set correctly for message boxes; added icon for set list generator. 

0.2.5.121  12-Oct-2011  Feature: Showing categories and sub categories for patches in GUI. 

                        Feature: Clear selected program(s) or bank(s). 

                        Improv:  Creation of XSL files for output generation in XML. 

                        Improv:  Removed Set Lists radio button if not supported by model. 

                        Improv:  Removed 'Content Type' column and 'Description' column from list views if not filled. 

                        Bug Fix: Prevented crash for program usage/combi content list generator for Karma PCGs. 

                        Bug Fix: Removed possibility to copy programs/combis between a Korg Triton PCG and Korg Karma PCG. 

                        Bug Fix: Edit window has an icon now to prevent being unnoticed when unfocused.  

0.2.5.121? 14-Oct-2011  Bug Fix: Fixed problem with saving PCG files. 

0.2.5.123  16-Oct-2011  Bug Fix: Fixed category crash for Korg Triton (Karma) models. 

0.2.6.125   2-Nov-2011  Feature: Support for (U-)AA- to (U-)GG banks, added with OS update 1.5 (Kronos only and UNTESTED!). 

                        Improv:  Patch List shows categories/sub categories (both Text, CSV and XML file format). 

                        Improv:  Patch List can be sorted by category. 

                        Improv:  Patch List output for CSV and XML slightly improved (and a bit changed). 

                        Improv:  Possibility to use new line characters in a set list slot description (Kronos only). 

                        Improv:  Number of characters for patch names/descriptions is shown in the edit screen. 

                        Bug Fix: Prevented crash when copying set lists slots using combis from U-A..U-G; Kronos only. 

                        Bug Fix: Prevented strange symbols for (sub) categories when loading PCGs without Global chunk. 

0.2.7.126  21-Nov-2011  Feature: Create instrument definition files for Cubase. 

                        Improv:  Create all generatable lists in ASCII table format. 

                        Improv:  Generate a new kind of Combi Content list (showing timbres by index) 

                        Improv:  Set list slots can be cleared. 

                        Improv:  Copy/Paste mode has a Recall button to recall the copied copy clipboard. 

                        Improv:  Added link to KronosHaven.com in the about box (new news site/forum for Korg Kronos). 

                        Improv:  Added link to Robert Rosen's site (keyboardist/repair/patches). 

                        Bug Fix: Enables the Copy and other buttons and disables Exit button when clipboard is empty. 

                        Bug Fix: Removed unused toolbar icon (arrow down). 

0.2.8.127  27-Nov-2011  Feature: Show favorite column for program/combis in PCG Window (Kronos only). 

                        Feature: Mark/Unmark programs/combis as favorite (in edit screen, menu and toolbar, Kronos only). 

                        Feature: Change categories and sub categories (depending on model) in edit screen. 
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                        Improv:  Use favorite setting as filter for generating all type of lists (Kronos only). 

0.2.9.129  17-Dec-2011  Feature: Support for user banks U-AA to U-GG (Kronos only). 

                        Improv:  Clearing a program or combi also removes the favorite setting (Kronos only). 

                        Improv:  Added OS version in status bar (for Kronos OS1.5 only). 

                        Improv:  Added external link window (removed from about window). 

                        Improv:  Added more external links (Kid Nepro, Dreamland Studio and Onksor). 

                        Improv:  Added descriptional text with short combi content lists. 

                        Improv:  Added copyright symbol in title and copyright mark in each source file. 

                        Improv:  Show About box and External Links window in taskbar, for easier nvavigating if unfocussed. 

                        Bug Fix: Trinity MOSS/Z1 files froze the app, changed into a more clear error message. 

                        Bug Fix: Patch list ASCII table substitute new lines for \ characters preventing disrupted columns. 

                        Special: Christmass ball icon (will be removed in a next update). 

0.3.0.137  30-Dec-2011  Feature: Long combi content list generation with important parameters of the used timbres. 

                        Feature: Compact patches, i.e. move the empty patches downwards. 

                        Feature: Keyboard shortcut key html file added in Help menu. 

                        Improv:  The dirty flag now works correct (before it sometimes was shown without a real change). 

                        Improv:  When no patches are pasted, a message box is shown with possible reasons. 

                        Improv:  Added and changed some keyboard shortcuts. 

                        Bug Fix: Prevent a crash for trying to edit a program/combi from a PCG file without Global chunk. 

                        Bug Fix: The status bar does not show the model including " OS" if no OS version is displayed. 

                        Bug Fix: Pasting of multiple selected patches did not work (correctly). 

                        Bug Fix: Cleaned up footer line for compact combi content list. 

                        Bug Fix: Prevent crash for OS1.5 combi content list generation using GM programs. 

                        Special: Changed the Christmass ball into a Fireworks symbol. 

 0.4.0.139   5-Jan-2012 Feature: Added a donation button (please consider if you think this app is useful). 

                        Feature: Timbres list for managing timbres inside a combi. 

                        Feature: Timbres can be moved up and down inside a combi (without affecting sound). 

                        Feature: Timbres can be cleared. 

                        Feature: Set list name can be changed in an edit window in the PCG window (Kronos only). 

                        Improv:  Set list name is shown in the bank list view in the PCG window (Kronos only). 

                        Improv:  When combis are cleared, timbres are cleared (several parameters are cleared). 

                        Improv:  Compacting patches can only be performed when at least 2 patches have been selected. 

                        Bug Fix: Fixed unfilled columns for GM/unpresent timbres in long combi content list. 

                        Bug Fix: Dirty flag was not reset after saving/saving as command. 

                        Special: Removed special event icon. 

0.4.1.140  15-Jan-2012  Improv:  Windows are opened at the same size  

0.4.2.144  18-Jan-2012  Bug Fix: Prevent M3 PCG files showing 'file unavailable' (M3 only). 

0.5.0.148  25-Jan-2012  Feature: Show song names of a SNG file. 

                        Feature: Show used samples/sample files of a SNG file. 

                        Improv:  Added two columns for set list slots: Timbre ID and name where it refers to. (Kronos only). 

                        Improv:  Multiple files can be selected in the open dialog window. 

                        Improv:  A wait cursor is shown while opening/saving files. 

                        Improv:  When opening a file that is already opened, the file name is displayed with an info message. 

                        Improv:  PCG file can only be saved if it has been changed (asterix symbol is shown). 

                        Improv:  Status bar shows active file type (PCG or SNG). 

                        Improv:  Status bar shows Triton model (i.e. LE, Extreme etc). Copy/Paste Triton in family works. 

                        Bug Fix: Increased speed of copy/paste/move up/down and compact functions. 

                        Bug Fix: Prevented unneccessary warnings of the same file being already opened. 

1.0.0.150  10-Apr-2012  Feature: Created a PDF manual (see www.korgforums.com/support/kronos/Manual%20PCG%20Tools.pdf). 

                        Improv:  Replaced shortcut keys help page with link to manual. 

                        Improv:  Changed the icon and logo in the about window to the new design (created by Mathieu Maes). 

                        Improv:  Added people and changes text in the about window. 

                        Improv:  Initial PCG/Song window size reduced to 400x300. 

                        Improv:  Defined minimum sizes for scalable windows to prevent distortion. 

                        Improv:  More shortcut keys are shown after menu items which already had a shortcut key. 

                        Improv:  Windows can be closed with Ctrl+F4. 

                        Improv:  Improved text of an information copy/paste window. 

                        Improv:  New external links added to PCGTools@KorgForums, korg.com, Keller12 and Kronoscopie. 

                        Improv:  Added error icon and default caption for several error/warning dialog windows. 

                        Improv:  All relevant dialog type windows are now centered in the middle of the application. 

                        Improv:  Improved checking for duplicated open files (case insensitive now). 

                        Bug Fix: Multiple items can be selected by keyboard in a correct way. 

                        Bug Fix: After moving up/down patches, extending a keyboard selection works correctly. 

                        Bug Fix: Fixed a formatting problem in the table output of the differences list. 

                        Bug Fix: Usage of return/line feeds in set list descriptions fixed (Kronos only). 

                        Bug Fix: Prevented crash when double clicking a non combi bank (in certain conditions). 

                        Bug Fix: Shown more timbre parameters for GM programs in combi window. 

                        Bug Fix: Fixed typo in the copy/paste Exit warning dialog. 

                        Bug Fix: Prevented several crashes related to copy/paste between incomplete PCG files. 

                        Bug Fix: For a long Combi Content List, filtered program banks are now taken into account. 

                        Bug Fix: Prevented GM programs being shown in Programs Usage List when Favorite filtering is enabled. 

1.0.1.167  18-Apr-2012  Improv:  Added Karo to External links window. 

                        Bug Fix: To prevent issues, move up/down patches only works for single selection. 

1.1.0.168   6-May-2012  Feature: Cut/Paste functionality, renamed copy/paste occurences to cut/copy/paste. 

                        Improv:  Changed text of hints in Cut/Copy/Paste settings. 

                        Improv:  Removed Copy/Paste Help button and dialog text (not needed now manual is available). 

                        Improv:  Added Supernatural Heroes to External links window. 

                        Bug Fix: Prevented crash when clearing combis for workstation not supporting sub categories. 

                        Bug Fix: Fixed keyboard short cut text for Move Up and Move Down commands in menu. 

1.1.1.169   9-May-2012  Improv:  Added a chapter in the manual for history changes. 

                        Improv:  Added Toon Martens Project to the external links window (and manual). 

                        Improv:  Added kronos-mw, a French language Kronos site to the external links window (and manual). 

                        Bug Fix: Prevented copying programs in the clipboard when cutting combinations or set list slots. 

                        Bug Fix: Prevented wrongly cut combinations and set list slots including references. 

1.1.2.172  17-May-2012  Bug Fix: Fixed problems with cut/copy/paste Kronos (1.5 or later) PCG files. 

                        Bug Fix: Fixed problem with identical patches (from cut/copy/paste settings) between PCG files. 

1.2.0.174  25-Jun-2012  Improv:  New theme/UI look for the complete software (thanks to Vanni). 

                        Improv:  Added splash screen with a random donator name/logo. 

                        Improv:  New screen for thanking Oasys donators of Korg Kronos voucher codes. 

                        Bug Fix: Fixed menu items for setting cut/copy/paste settings and exiting cut/copy/paste mode. 

1.3.0.181   5-Aug-2012  Improv:  Added an Assigned Clear Program for clearing timbres in the Combi Window. 

                        Improv:  Added favorite column in patch list generation files (ASCII, table, CSV, XML). 

                        Improv:  Correctly aligned texts of controls in the List Generator, Filter Set Lists group box. 

                        Improv:  Korg Kronos PCG files always shows its OS/PCG number (1.0/1.1, 1.5/1.6 or 2.0). 

                        Improv:  Korg M3 PCG files always shows its OS/PCG number (OS1.x or OS2.0 for expanded version). 

                        Improv:  Swapped Show and Edit menu options in main menu. 

                        Improv:  When copying M3 patches, the version of the file is no longer changed (M3 only). 

                        Improv:  Added Options/Settings menu and redirect PCG windows button. 

                        Improv:  Settings menu unavailable during active copy/paste action. 

                        Improv:  Added (Kronos) AL-1 Editor to external links. 

                        Improv:  The workstation model and number of samples used by a SNG file are now shown. 

                        Improv:  Removed double menu item 'Show Timbres' in Tools menu in main window. 
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                        Improv:  Song window size is now also memorized when closed. 

                        Bug Fix: Song files could not be closed by the File menu, Close sub menu item. 

                        Bug Fix: Widened program IDs of banks U-AA to U-GG in PCG Window (those were still truncated). 

                        Bug Fix: M3 patches between V1.x and V2.0 can no longer be cut/copy/pasted. 

                        Bug Fix: Show correct error when pasting patches between incompatible Korg workstation models. 

                        Bug Fix: Korg Triton Studio shows correct bank names for combis EXB-A and further. 

                        Bug Fix: Save last window dimensions of the Combi Window. 

                        Bug Fix: The Exit command from the File menu crashed the application in some cases. 

                        Support: Support for Korg Kronos OS2.0 generated PCG Files. 

                        Support: Support for Korg Kronos X generated PCG Files. 

                        Event:   Korg is going to release a new workstation: the Korg Kronos X.                         

1.3.1.182   6-Aug-2012  Bug Fix: PCG Files could not be read at all (in version 1.3.0.181). 
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13 Wish List 

13.1 Summary 

In this appendix all gathered wishes from either users or the designer are described. 
Every item is described in detail in the subsequence paragraphs. 
 

Category Item 

Support Support for Korg X50 

Support Support for Korg microStation 

Support Support for Korg microX 

Support Support for Korg Trinity 

Support Support for Korg arrangers 

Connectivity MIDI support 

GUI Save/restore window properties 

GUI Maximizing/minimizing Windows 

GUI Auto save PCG Files 

GUI Drag & drop 

GUI Tip of the Day 

GUI Read zip Files 

GUI Undo/redo 

Copy & Paste Show uncopied patches reason 

Copy & Paste Copy timbres in combi 

Copy & Paste Copy/paste between Oasys/Kronos patches. 

Copy & Paste Insert patch in PCG window. 

PCG Files Differ PCG files list 

PCG Files Create new PCG file 

PCG Files Merge two PCG files 

Banks Move bank up or down 

Banks Swap bank 

Banks Delete/insert bank 

Banks Reassign type of program bank (sampled/modeled) 

Patches General Capitalization of names/descriptions 

Patches General Patch database 

Patches General Patch usage marker 

Patches General Patch problem list 

Patches General Controller route list 

Patches General Insert/delete patches 

Patches General Sort patches 

Patches General Swap two patches 

Patches General Clear warning 

Patches General Remove unused patches 

Programs Specific Multiple program edit 

Combis Specific Multiple combi edit 

Combis Specific Multiple timbres edit 

Combis Specific Sorting timbres inside combi 

Combis Specific Combine programs into a combi 

Set Lists Specific Band set list generator 

Set Lists Specific Multiple set list slot edit 

Set Lists Specific Convert programs/combis to set list slots. 
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List Generator General Generate header 

List Generator General Keep current values when changing list type 

Samples Samples reference list 

Samples Samples usage list 

Samples Create list of KSC file 

Samples Sample changer 

Global Section/Categories Category manager 

Global Section/Categories Show always category/sub category names 

Global Section/Categories Create category amount list 

Karma Add Karma GE info in patch list 

Sequencer/Songs Show timbres window for songs 

Sequencer/Songs Convert into combi 

Sequencer/Songs Create list of  songs/used samples 

Sequencer/Songs Autoload PCG/song file 

Sequencer/Songs Connect PCG/song file 

Sequencer/Songs Autofix songs when moving programs 

DAWs Generate Cubase file 

DAWs Generate Cakewalk file 

DAWs Generate Logic file 

DAWs Generate Reaper file 
Table 31: Wish List 

13.2 Support 
Support for Korg X50 

Description Add support for Korg X50. 

Rationale X50 users also want to use PCG Tools. 

Requester - 

Implementation - 

Open Issues Different PCG file format. 

 
Support for Korg microStation 

Description Add support for Korg microStation. 

Rationale microStation users also want to use PCG Tools. 

Requester - 

Implementation - 

Open Issues Different PCG file format. 

 
Support for Korg microX 

Description Add support for Korg microX. 

Rationale microX users also want to use PCG Tools. 

Requester - 

Implementation - 

Open Issues Different PCG file format. 

 
Support for Korg Trinity 

Description Add support for Korg Trinity. 

Rationale Trinity users also want to use PCG Tools. 

Requester - 

Implementation - 

Open Issues Different PCG file format. 
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Support for Korg arrangers 

Description Add support for Korg arrangers. 

Rationale Arrangers users also want to use PCG Tools. 

Requester - 

Implementation - 

Open Issues Different PCG file format if already. 

13.3 Connectivity 
MIDI support 

Description Use MIDI Sysex messages for sending and receiving patches. 

Rationale By a direct MIDI connection, no swapping of media is needed, changes can 
immediately be sent to the workstation. Fine granular editing capabilities makes 
much more sense. 

Requester - 

Implementation Define receive/send functions. 

Open Issues MIDI library needed. 

13.4 GUI 
Save/restore window properties 

Description Save/restore window properties like column widths. 

Rationale Currently only window sizes are stored and restored. 

Requester - 

Implementation Save properties in settings. 

Open Issues Define what columns are currently present. 

 
Maximizing/minimizing Windows 

Description Possibility to minimize/maximize windows. 

Rationale Currently disabled. 

Requester - 

Implementation Check if supported by used library. 

Open Issues - 

 
Auto save PCG Files 

Description Auto Saves modified PCG files changed, possibly with backup function. 

Rationale It is easy to forget saving. Also automatic backup is a nice addition. 

Requester - 

Implementation Save every x minutes, define x in preferences. 
Use preferences to set the algorithm (overwrite original file, or create backup 
and overwrite original, or create backup only). 

Open Issues Auto save for SD cards/floppy can take some time. 

 
Drag and drop 

Description Add drag and drop functionality for moving/cut/copy/pasting patches. 

Rationale Drag and drop is easier than using a keyboard. 

Requester - 

Implementation Trivial 

Open Issues When using cut/copy/paste, not all items can be dropped at the same location 
(i.e. when the clipboard contains both programs and combis, it is not possible). 
Workaround is to drop the first element, and rest with using the keyboard. 
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Tip of the day 

Description When starting the application, show a tip of the day. 

Rationale Not everybody reads the manual and it gives an easy way to learn more 
features. 

Requester - 

Implementation Trivial 

Open Issues None. 

 
Read zip Files 

Description Read zip files and automatically extract PCG or SNG files. 

Rationale Most downloaded files are in zip format. This would prevent a manual needed 
zip. 

Requester - 

Implementation Use internal zip functionality from .NET. 

Open Issues Open both PCG and SNG file? Or every possible PCG and SNG file. 

 
Undo/redo 

Description Support for undoing and redoing past commands. 

Rationale Most commands are now irreversible. 

Requester - 

Implementation Memento design pattern. Or just copy the complete content (or better: changed 
contents). 

Open Issues Very costly memory wise. E.g. a Kronos PCG file is 45 MB, each history state can 
be upto 45 MB. Besides a major architectural change is needed or a more or less 
dumb algorithm. 

13.5 Copy & Paste 
Show uncopied patches reason 

Description When cut/copy/pasting results in no copy/paste a big window is shown with all 
possible reasons. This should be split into the exact reason. 
Also when pasting programs in incompatible program banks (i.e. modeled versus 
sampled) no warning/error is shown. 

Rationale Easier to see what is the reason of uncopied/pasted patches. 

Requester - 

Implementation Trivial 

Open Issues None. 

 
Copy Timbres in combi 

Description Add cut/copy/paste of timbres inside a combi. 
Also preferably, add cut/copy/paste  between timbres.  

Rationale This functionality is not available on a workstation. 

Requester n.a. 

Implementation Add cut/copy/paste buttons to the Combi window. When cut/copied, the 
timbres are stored in the clipboard.  

Open Issues How to handle effects? Will there be KARMA issues? 
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Copy/Paste between Oasys/Kronos patches 

Description Copy/Paste patches between Korg Oasys and Kronos, for those patches that 
have compatible EXis. 

Rationale No automatic conversion in the Oasys. 

Requester - 

Implementation - 

Open Issues How to handle programs/combis using incompatible EXis? Different 
samples/sample set. 

 
Insert patch in PCG Window 

Description In a PCG window, instead of overwriting a patch that is pasted, insert it. 

Rationale Currently it is overwritten (or not possible to overwrite). 

Requester n.a. 

Implementation Add option in preference to select between giving a warning if a patch is deleted 
(the last of the bank) or if it should be possible or not. 
 
If the clip buffer is not filled, insert an empty patch. 

Open Issues Warning or error when the last patch should be removed? How to get an empty 
patch? 

13.6 PCG Files 
Differ PCG files list 

Description Create a list with the difference between two PCG files (from the same 
workstation model). 

Rationale Currently it is not possible to diff two PCG files. 

Requester n.a. 

Implementation Generate a list per selected patch which are different. 
E.g. short list: 
   Program Bank I-A: 1, 2, 6, 8, … 
   Combi Bank   I-C: 6, 33 
E.g. long list: 
   Patch          Name 1       Name 2  Content Diff 
   Program I-A000 Kronos Grand =       34 
Meaning 34 bytes differences, = means that the names are equal. 

Open Issues Add global differences. 
 

Create new PCG file 

Description Creates a new file from the specified workstation model. 
Optionally the contents can be set (which program banks, combi banks, set list 
slots and whether to add a global section). 

Rationale Currently this is not possible. 

Requester n.a. 

Implementation Use a full PCG file of each workstation model and remove all banks (and global?) 
or create from scratch? Using a full PCG and delete all unrequested banks/global 
section would be easiest. 

Open Issues Creating from scratch will be very tricky but the most clean solution. 
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Merge two PCG files 

Description Merge two PCG files, i.e. copy all programs/combis/set list slots from one PCG 
file to the other. 

Rationale Currently this is not possible. 

Requester n.a. 

Implementation Two alternatives:  
Dumb: start copying until the PCG file is filled (either it is finished ok or there is 
not enough space).  
Intelligent: First analyze duplicates, then calculate if the complete copy fits. If 
not, show a warning (possibility to continue). 

Open Issues What to do if both PCG files have global settings? What to do with incomplete 
copies (i.e. not all programs fits, combis/set list slots use uncopied programs?) 

13.7 Banks 
Move bank up or down 

Description Move a bank up and down. 

Rationale Currently not possible. 

Requester - 

Implementation - 

Open Issues Take care for Modeled/Sampled banks (change header), also check MOSS 
specific banks. 

 
Swap bank 

Description Swap two banks. 

Rationale Currently not possible. 

Requester - 

Implementation Reuse Move Bank Up or Down 
Open Issues - 

 
Delete / insert Bank 

Description Delete or Insert a bank. 

Rationale Currently not possible. 

Requester - 

Implementation - 
Open Issues See delete/insert of patches. 

 
Reassign type of program bank (sampled/modeled) 

Description Reassign the type of a program bank if supported (Sampled Bank <-> Modeled 
bank) 

Rationale Currently not possible. 

Requester - 

Implementation Add warning (patches are destroyed). 
Open Issues - 
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13.8 Patches General 
Capitalization of names/descriptions 

Description In multi edit mode (and single), add the possibility to (de)capitalize names of 
patches and descriptions of set list slots. 

Rationale It is tedious to change this per patch. Capitalized names are used sometimes to 
denote own creations. Also capitalized names are easier to read (especially in 
descriptions of set list slots). 

Requester - 

Implementation Add option in both single and multi edit windows. 

Open Issues - 

 
Patch database  

Description Manager for patches of all present PCG files (from different workstations). 

Rationale Easier to handle/find/generate lists to have all patches in one big Database file. 

Requester n.a. 

Implementation Create a database that can handle all possible patches. 

Open Issues Definition of database. 

 
Patch usage marker 

Description Mark names of program that are used in combis and set list slots and mark 
combis that are used in set list slots. 
Also create the possibility to generate a list with markers. 

Rationale It is hard to see which programs/combis are used in other patches currently. By 
marking them it can be instantly seen on the workstation itself. 

Requester n.a. 

Implementation Add a menu option to add (or delete) the (usage marker) symbol can be added 
to the end of the name (e.g. *). This symbol can be set in the preferences. 
In the set list generator, add a list type to show marked patches. 

Open Issues What if the name already has the maximum amount of characters? 
Also, it is not possible to see the difference between a name being marked or 
having the last symbol equal to the usage marker symbol. 

 
Patch problem list 

Description Generate a list of possible patch problems, like: 
Patches with identical names 
Patches with identical content except for the name (exclude set list slots?) 
Combis with a non init or blank name with filled timbres. 
Combis without any used timbres. 
Programs, combis and set list slot with samples from unloaded EXSs. 

Rationale For users, it is very handy to have this information. 

Requester n.a. 

Implementation Create a different selection window for these options? For the samples, add a 
preference window to fill in which EXSs are loaded and store them by 
preferences.  

Open Issues EXs list only for Kronos? 
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Controller route list 

Description For the selected patches, generate a controller route list, such as aftertouch, 
velocity, VJS, JS, panel knobs/sliders etc.. 

Rationale Currently it is not possible to see what controllers are controlling which 
functions and in what amount. 

Requester n.a. 

Implementation Add this option also to the PCG window because one program/combi can 
generate a big file.  
Add parameters for all controllers (for all workstation models).  
Also take into account controllers for effects, SW1/2 and pedal functionality, 
range of controller values. 

Open Issues What if Global section is not present? (missing SW1/2 functionality). 
 

Insert/delete patches 

Description Insert (before)/delete the selected patch. 

Rationale Currently not possible (except by moving down the last patch). 

Requester n.a. 

Implementation Add preference option to ask for warning or not. 
For insert, warning when skipped? 

Open Issues Move further patches until blank/init patch encountered?t 
 

Sort patches 

Description Sort the selected patches or banks. 

Rationale Currently it is only possible manually by moving programs up/down and even 
within the same bank. 

Requester - 

Implementation Two alternatives: 

Sort alphabetically only 
Sort by a user specified key (e.g. alphabetically, by category/sub category, by 
engine type (Kronos). 
Optionally store last order key settings. 

Open Issues - 

 
Swap two patches 

Description Swap two patches. 

Rationale Currently not possible. 

Requester - 

Implementation Swap two patches (also from different banks if possible). Either by selecting one 
patch, then go to another bank and select one patch. If this is infeasible: have 
the following algorithm: 
If one patch is selected, show a window to ask for the second swap patch. 
If two patches are selected, swap them (only possible internally in one bank). 

Open Issues - 
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Clear Warning 

Description Show a warning when used patches are cleared. 

Rationale Currently no warning shown; it might result in broken combis/set list slots. 

Requester - 

Implementation Add a preference with options: no warning, always warning, warning when 
patches used. 
If warning when patches used selected: show a warning how many (or exactly 
which) selected patches are used in combis/set list slots and ask to continue or 
not. 

Open Issues - 

 
Remove unused patches 

Description If combi(s) are selected: clean all programs not used in those combis. 
If set list slot(s) are selected: clean all programs/combis not used in those set list 
slot(s) and programs referenced in those combis. 
Also compact all remaining programs/combis. 

Rationale Assuming that combis or set list slots contains all that the user wants to keep, 
everything else can be cleaned.  

Requester - 

Implementation - 
Open Issues - 

13.9 Programs Specific 
Multiple program edit 

Description Perform editing on all selected programs, such as volume. 

Rationale It is tedious to change this per program. 

Requester - 

Implementation Use different options like: 
Set to fixed value. 
Add fixed value (show min/max values and clipping Boolean) 

Add percentage (show min/max values and clipping Boolean) 

Open Issues Volume parameters may differ per EXi type. 

13.10 Combis Specific 
Multiple combi edit 

Description Perform editing on all selected combis, such as volume, transpose. 

Rationale It is tedious to change this per combi. 

Requester - 

Implementation Call the Timbres Edit for each selected combi.  
Use the same options as in Multiple Program Edit 

Open Issues - 
 

Multiple timbres edit 

Description Perform editing on all selected timbres in a combi, such as volume, transpose. 

Rationale It is tedious to change this per timbre. 

Requester - 

Implementation Add the command in the Timbres window. 
Use the same options as in Multiple Multi Program Edit. 

Open Issues - 
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Sorting timbres inside combi 

Description Sorting the selected timbres in a combi. The sorting key should be MIDI Channel, 
Bottom Key Zone, Top Key Zone, Bottom Key Velocity, Top Key Velocity. External 
timbres should be moved to the end. Timbres which are set to Off or Mute or 
have velocity 0 removed. 

Rationale When changing combis, often timbres are assigned in random order or added 
later. By sorting, the combi will be put in a better order. 

Requester n.a. 

Implementation Add a sort button to the Timbres window. Add the possibility to leave a gap 
between timbres of different MIDI channels. 

Open Issues Should the sorting order be flexible? (e.g. added to the preferences?) 
What if the gap size is not possible? Proposed solution: start adding gaps from 
left to right while possible. 

 
Combine programs into a Combi 

Description Select one or more programs and combine them into a combi, by creating 
timbres to the selected programs. Also copy effect settings (optional). 

Rationale Currently not easily possible. Effect copying can be set on most workstations. 

Requester n.a. 

Implementation Effect copying is very tricky. 

Open Issues What is the best algorithm (or algorithm used by Korg Kronos) to copy effect 
settings? Should in case of too less effects, similar effects be merged (preference 
option?). 

13.11 Set Lists Specific 
Band set list generator 

Description Generate a band set list (as PDF, Word or RTF document) for bands, based on set 
lists. 

Rationale Bands need a printout of their set list(s) during play. 

Requester - 

Implementation Create a document, based on some kind of preferences, possibly with a logo etc. 

Open Issues Maximum number of songs, flexibility of the document/preferences. 

 
Multiple set list slot edit 

Description Perform editing on all selected set list slot, such as volume, transpose. 

Rationale It is tedious to change this per set list slot. 

Requester - 

Implementation Use the same options as in Multiple Program Edit. 

Open Issues - 

 
Convert programs/combis to set list slots 

Description Automatically convert programs and combis to set list slots. 

Rationale Currently this is only possible on the workstation (Kronos only). 

Requester - 

Implementation - 

Open Issues - 
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13.12 List Generator General 
Generate header 

Description Generate headers for generated lists. 

Rationale Currently it is not possible with what settings a list is generated. 

Requester - 

Implementation For text/table files, add a text header. For CSV files do not create a header (or 
use textual header), for XML file add an XSL header. 
Add an option for optionally generating a header in the Generate List window. 
 
Example: 
PCG Filename: PRELOAD.pcg 
Date of PCG File: 28 Sep 2010, 18:34 
Program Banks Present: I-A, I-B, … 
Combi Banks Present: I-A 
Set Lists Present: Yes 
Global Present: No 
Date of List generation: 14 Jul 2011, 12:13  
List Type: Patch List  
Filter: On Text: Piano  
Selected Program Banks I-A I-B I-C  
Ignore Empty Programs: Yes 
Selected Combi Banks: U-G  
Selected Set Lists: 1-5  
Sort: Alphabetical  

Open Issues Store optional enable/disable headers in preferences? 

 
Keep current values when changing list type 

Description Currently values are mostly set to default when changing the list type in the set 
list generator. 

Rationale It is time consuming for a user to change them every time. 

Requester - 

Implementation - 

Open Issues - 

13.13 Samples 
Samples references list 

Description Create a list of programs/combis/set lists to samples list. 

Rationale Find out which programs/combis/set lists use which samples. 

Requester n.a. 

Implementation Create lists like: 
Extended 
ID   Name     S.Sets Samples 
Prg I-A000 KRONOS Grand Piano KSC01 1, 2 
010/034 … KSC01 1, 2, 5, 8, 12, 14, 16-20, 37 
 
Summary 
S.Set Size Samples 
KSC01 50 1, 2, 5-8, 16-20 

Open Issues Name of sample sets need to be gathered (fixed?). 
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Samples usage List 

Description Create a list of samples to programs/combis/set list slots list. 

Rationale Find out which samples are used in which programs/combis/set list slots. 

Requester n.a. 

Implementation Create lists like: 
 Set Sample Used In 
 KRS01 0 Prg I-A000, Cmb I-A000, 010/020 
 KRS50 12 … 

Open Issues Name of sample sets need to be gathered (fixed?). 

 
Create list of KSC file 

Description Generate a list with the contents of a KSC file. 

Rationale Find out the contents of a KSC file. 

Requester Ask Sharp for KSC Gen application. 

Implementation To be decided. 

Open Issues - 

 
Sample changer 

Description Change specific sample numbers in a selection of programs, combis or set list 
slots to different sample numbers. 

Rationale It is tedious to change the multi samples values in all affected programs 
manually. 
KRONOS (X): Also some do like one piano better than another (e.g. Japanese 
Piano instead of Austrian Piano). With this option all patches can make use of 
another piano instead of having to change multiple patches one by one. It can 
be used to not load a certain EXs and move all unloaded multisamples to loaded 
ones. 

Requester - 

Implementation An external list is needed which maps a list of samples to another list of samples 
(1 to 1). 

Open Issues Format of this list has to be specified. 

13.14 Global section/Categories 
Category manager 

Description Possibility to change category and sub category names in the global section. 
Possibility to change the category and/or sub category of a selection of patches. 

Rationale Changing texts on a workstation is quite tedious. Also it is not possible on a 
workstation to change the category and/or sub category of multiple patches at 
the same time. 

Requester n.a. 

Implementation Add the possibility to change the category/sub category in the edit window of 
programs and combis. 
Also add a menu item to change the category/sub category (in case of multiple 
patches are selected). Also one or more selected banks can be changed in one 
action. 
Add a window to manage the current category/sub category names and save 
them in the global section. 

Open Issues When there is no global section, names of categories and sub categories are not 
available. Possibly implement XXX first. 
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Show always category/sub category names 

Description Currently only category/sub category names are shown when a global section is 
part of the PCG file. Use a default or alternative PCG file for these names. 

Rationale Number of categories/sub categories are difficult for interpretation. 

Requester - 

Implementation Create a preference what to select (only names if global as now, default names 
(hardcoded), names from alternative PCG file). 

Open Issues If names from alternative PCG file: one needed per workstation model (?). 
 

Create category amount list 

Description Generate a list with categories (and sub categories?) amounts from a PCG file. 

Rationale Add more information to the  

Requester - 

Implementation Example: 
 
Category    Sub Category  Programs  Most in Banks  Combis   Most in Banks  
Piano       (all)          126      I-A (38)         18     U-C (16) 
Piano       A. Piano        12      I-A (14)         16     U-C (16) 

… 
 
Most in Banks calculates the bank where the most amount of that category/sub category are 
present including the amount. Sub category (all) means that it counts every patch of that category, 
independent of the sub category. 

Open Issues If names from alternative PCG file: one needed per workstation model (?). 

13.15 Karma 
Add Karma GE info in patch list 

Description Add the Karma GE number/names in the patch list (optionally). 

Rationale Generate more information for users. 

Requester - 

Implementation - 

Open Issues GE names are not in the PCG file. 

13.16 Sequencer/Songs 
Show timbres window for songss 

Description Show the timbres window, based on a song, instead of a combi. 

Rationale Currently not possible. 

Requester - 

Implementation Optionally with editing possibilities like move up/down. 

Open Issues - 

 
Convert into combi 

Description Convert a song into a combi. 

Rationale Currently not possible (only from combi to a song). 

Requester - 

Implementation - 

Open Issues - 
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Create list of songs/used samples 

Description In the List Generator, add the possibility to create a list of songs and samples 
used. 

Rationale Currently not possible. 

Requester - 

Implementation - 

Open Issues - 
 

Autoload PCG/song file 

Description When a PCG file or SNG file is loaded, automatically load the other file. 

Rationale User convenience. 

Requester - 

Implementation When showing timbres, use the patch names from the PCG file. 
Open Issues - 

 
Connect PCG/song file 

Description When two files are loaded, add a function to connect them. 

Rationale When named differently, PCG/SNG files should be connectable too. 

Requester - 

Implementation When showing timbres, use the patch names from the PCG file. 
Multiple SNG files should be connectable to one PCG file.  
Preference: store these connections? 

Open Issues - 

 
Autofix songs when moving programs  

Description When programs are moved and a PCG/SNG file is connected, automatically fix 
the SNG file accordingly. 

Rationale Otherwise songs are broken. 

Requester - 

Implementation Check all connected SNG files. 
Open Issues - 

13.17 DAWs 
Generate Cubase file 

Description Create a file from the current PCG file to be used in Cubase. 

Rationale Useful for Triton owners and bit less for M series and Oasys/Kronos (X) owners 
because the editor from Korg can be used. 

Requester - 

Implementation Currently a file is created but now fully supporting all Cubase versions. 

Open Issues - 

 
Generate Cakewalk file 

Description Create a file from the current PCG file to be used in Cakewalk. 

Rationale Useful for Triton owners and bit less for M series and Oasys/Kronos (X) owners 
because the editor from Korg can be used. 

Requester - 

Implementation - 

Open Issues - 
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Generate Logic file 

Description Create a file from the current PCG file to be used in Logic. 

Rationale Useful for Triton owners and bit less for M series and Oasys/Kronos (X) owners 
because the editor from Korg can be used. 

Requester - 

Implementation - 

Open Issues - 

 
Generate Reaper file 

Description Create a file from the current PCG file to be used in Reaper. 

Rationale Useful for Triton owners and bit less for M series and Oasys/Kronos (X) owners 
because the editor from Korg can be used. 

Requester - 

Implementation - 

Open Issues - 
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